
ESTIMATE USER
GUIDE

PROJEC
T COST MANAGE

MENT



Information in this document is subject to change without notice. Companies, names and data used in
examples are fictitious.

Copyright ©2020 by InEight. All rights reserved. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express permission of InEight.

Microsoft Windows, Internet Explorer and Microsoft Excel are registered trademarks of Microsoft
Corporation.

Although InEight Estimate has undergone extensive testing, InEight makes no warranty or
representation, either express or implied, with respect to this software or documentation, its quality,
performance, merchantability, or fitness for purpose. As a result, this software and documentation are
licensed “as is”, and you, the licensee are assuming the entire risk as to its quality and performance. In
no event will InEight be liable for direct, indirect, special, incidental or consequential damages arising
out of the use or inability to use the software or documentation.

Page 2 of 565 InEight Inc.  |  Release 20.1

Release 20.1
Last Updated: 17 July 2020



InEight Inc.  |  Release 20.1 Page 3 of 565

CONTENTS
INTRODUCTION 23

Course Description 23
Course Objectives 23
How to Use this Manual 23
Lessons 23
Lesson Format 24
Call-Outs 25
Ongoing Use 25

LESSON 1 — ESTIMATING CORE CONCEPTS 27
1.1 Overview of the Estimating Process 29
Step 1 – Enter Project Details 30
Step 2 – Enter Proposal Deliverables 31
Step 3 – Calculate Direct & Indirect Project Cost 31
Step 4 – Add Markup, Contingency, & Fees 32
Step 5 – Distribute Cost + Markup to required Structure 33

1.2 Key Concepts and Terms 33
1.2.1 Job Folder 34
1.2.2 Library 34
1.2.3 Form 34
1.2.4 Cost Item 36
1.2.5 Pay Item 36
1.2.6 Resource 37
1.2.7 Resource Assembly 37
1.2.8 Cost Item Assembly 38

Lesson 1 Review 39
Lesson 1 Summary 39



LESSON 2 — GENERAL NAVIGATION 41
2.1 General Navigation 43

Step by Step — Launch InEight Estimate 43
2.1.1 Backstage View 43
2.1.2 Overview – Backstage View 44
2.1.2.1 Archive / Restore 44
Step by Step — Archive and Restore a Job 44
2.1.2.2 Settings 45
2.1.2.3 Prompt to Save 46
2.1.2.4 Decimal Precision 46

2.1.3 Open a Job Folder 47
Step by Step — Open a Job Folder 47

2.1.4 Help Bubbles 48
2.1.5 Data Map 49
2.1.6 InEight Estimate Layout 50
2.1.7 Overview - Setup Tab 50
2.1.8 Overview – Estimate Tab 51
2.1.9 Overview – Quote Tab 52
2.1.10 Overview – Price Tab 53
2.1.11 Overview – Execution Tab 53
2.1.12 Overview - System Tab 55
2.1.13 Library 55
2.1.14 Open Forms 55

Step by Step — Open Forms 56
2.2 System Settings 57

Step by Step — System Settings 58
2.3 Columns 59
2.3.1 Move Columns 59

Step by Step —Move Columns 59
2.3.2 Sort and Filter Columns 61

Step by Step — Sort Columns 61
Step by Step — Filter Columns 61
2.3.2.1 Filter Editor Overview 62
Step by Step — Filter Editor 63

2.3.3 Group Columns 64
Step by Step — Group Columns 64

2.3.4 Saved Views 65
Step by Step — Create a Saved View 66

Lesson 2 Review 67

Page 4 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



Lesson 2 Summary 67

LESSON 3 — LIBRARY SETUP 69
3.1 Library Overview 71
3.1.1 Library Tabs 72
3.1.1.1 Setup Tab 72
3.1.1.2 Estimate Tab 74
3.1.1.3 Execution Tab 75
3.1.1.4 System Tab 76

3.2 Library Job Properties 77
3.3 Library Foundation Setup Data 78
3.4 Resources 79
3.4.1 Library Resource Rate Register 80

Overview – Library Resource Rate Register 81
3.4.2 Labor Resources 82
3.4.3 Resource Rate Record 82

Overview – Resource Rate Record 83
Step by Step — Create a Labor Resource 86

3.4.4 Construction Equipment Resources 90
3.4.5 Rented Equipment Resources 90

Step by Step — Create a Rental Equipment Resource 91
3.4.6 Equipment Consumption Rates 92
3.4.7 Non-Hourly Rate Calculator 93

Step by Step — Non-Hourly Rate Calculator 93
3.4.8 Installed Materials, Installed Equipment & Supplies Resources 94

Step by Step — Create an Installed Material Resource 95
3.4.9 Unique Resources 96

3.5 Resource Assemblies 97
3.5.1 Library Resource Assembly Register 97

Overview – Library Resource Assembly Register 97
3.5.2 Resource Assembly Record 98

Overview – Resource Assembly Record 98
Step by Step — Create a Resource Assembly 99

Exercise 3.1 — Create Resources & Resource Assemblies 101
Lesson 3 Review 104
Lesson 3 Summary 104

LESSON 4 — PROJECT SETUP 105
4.1 Job Creation 107

Step by Step — Create a New Job 107

InEight Inc.  |  Release 20.1 Page 5 of 565

Estimate User Guide



4.2 Job Properties 109
4.2.1 Overview Tab 109
4.2.2 Security Tab 110

Step by Step — Set Up Job Level Security 111
4.2.3 Cover Sheet Tab 111
4.2.4 Cost Basis Tab 112
4.2.5 Shift Rate Calculator 113

Step by Step — Shift Rate Calculator 114
4.2.6 Import Filtered Resources 116

Step by Step — Import Filtered Resources 117
4.2.7 Fuel Cost Tab 118

Step by Step — Enter Fuel Costs 118
4.2.8 Job Folder Tags Tab 119
4.2.9 Schedule Tab 119
4.2.10 Other Job Properties Tabs 120

Exercise 4.1 — Define Job Properties 122
4.3 Pay Item Creation 126
4.3.1 Overview – Pay Item & Proposal Register 127

Step by Step — Create a Pay Item 127
Exercise 4.2 — Create Pay Items 129
Lesson 4 Review 130
Lesson 4 Summary 130

LESSON 5 — ESTIMATE DIRECT COSTS 131
5.1 Cost Breakdown Structures 133
5.1.1 Cost Item Terminology 134
5.1.2 Work Breakdown Structures 135
5.1.3 Locked vs. Unlocked Approach 136
5.1.4 Take-Off Quantities 138

Step by Step — Adjust Take-Off Quantities 139
5.2 Cost Item Creation 140
5.2.1 Insert Subordinate Cost Item 140
Option 1 140
Option 2 140

5.2.2 Insert Cost Item 141
Option 1 141
Option 2 142
Step by Step — Create a Subordinate Cost Item 143

5.2.3 Move Cost Items 143

Page 6 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



Exercise 5.1 — Create Cost Items 145
5.3 Costs and Production 146
5.3.1 Cost Item Record 146
5.3.2 Cost Sources 147
5.3.2.1 Plug Tab 148
5.3.2.2 Detail Tab 149

5.3.3 Plug Costs 150
Step by Step — Define a Plugged Cost 150

5.3.4 Detail Costs 152
5.3.4.3 Add Cost Detail 153
Step by Step — Add Cost Detail 153
5.3.4.4 Add Assembly 157
Step by Step — Define Cost Detail by Adding an Assembly 157

Exercise 5.2 — Define Cost Detail 160
5.4 Cost Item Details 162
5.4.1 Cost Item Setup 162

Step by Step — Adjust Shift Arrangements 163
5.4.2 Notes 165
5.4.3 Man-Hour Factors 166
5.4.4 Unique Identifier 167
5.4.4.1 Highlight Unique (Delta) Toggle 169

5.4.5 Cost Drivers 170
5.4.5.2 Split by Cost Type 172

5.4.6 Suspend Cost Items 173
Step by Step — Suspend a Cost Item 174
Step by Step — Unsuspend a Cost Item 175
5.4.6.3 Suspend Column 175

5.4.7 Adding Cost Adjustments 176
Exercise 5.3 —Manage Cost Item Details 178
Lesson 5 Review 179
Lesson 5 Summary 179

LESSON 6 — ESTIMATE INDIRECT COSTS 181
6.1 Indirect Costs Overview 182
6.1.1 Navigation to Indirect Costs 183

6.2 Default Indirect Cost Items 183
6.2.1 Independent Indirect Cost Items 183
6.2.1.1 Job Management & Equipment 183
Step by Step — Add Job Management & Equipment Costs 184
Step by Step — Add General Expense Costs 185

InEight Inc.  |  Release 20.1 Page 7 of 565

Estimate User Guide



6.2.2 Dependent Indirect Cost Items 186
6.2.2.2 Default Dependent Cost Item Deletion 187
Step by Step — Delete Existing Default Dependent Cost Items 187
6.2.2.3 Prime Bond 188
Step by Step — Define Prime Bond 188
6.2.2.4 Price % Add-On 190
Step by Step — Define a Price % Add-On 190
6.2.2.5 Direct Cost Add-On 192
Step by Step — Define a Direct Cost Add-On 192
6.2.2.6 Repositioning Dependent Cost Items 195

6.3 User-Defined Indirect Cost Items 196
Step by Step — Add User-Defined Indirect Cost Items 197

Exercise 6.1 — Define Indirect Costs 203
Lesson 6 Review 205
Lesson 6 Summary 205

LESSON 7 — FINALIZE THE ESTIMATE 207
7.1 Job Markup (Profit) 209
7.1.1 Target Price 209
7.1.2 Price Breakdown Structure 212
7.1.3 Markup vs. Margin 214
7.1.4 Define Profit 215
7.1.4.1 Profit as a Percentage of Target Price 216
Step by Step — Add Profit as a Percentage of Target Price 216
7.1.4.2 Profit Through Direct Cost Markup Record 217
Step by Step —Modify the Direct Cost Markup Record 217

7.2 Cost Estimate Audit/Review 219
7.2.1 Price Breakdown Structure Tabs 219
7.2.1.1 Markup Analysis 219
7.2.1.2 Cost Source 219
7.2.1.3 Resource Utilization 220
7.2.1.4 Subcontract Status 220
7.2.1.5 Vendor Status 221

7.3 Spread Target Price Over Pay Items 221
7.3.1 Current Price vs. Target Price 221
7.3.2 Proposal Recap 222
7.3.3 Spread the Target Price 222
7.3.4 Define Pricing for Pay Items Manually 223

Step by Step — Define Pricing Manually 223

Page 8 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



7.3.5 Use AutoPrice to Balance and Hit the Target Total 224
7.3 Step by Step 1 — Use AutoPrice to Balance and Hit the Target Total 225

7.3.6 Use AutoPrice to Unbalance and Hit the Target Total 225
7.3 Step by Step 2 — Unbalance Hit Target Total 225

Exercise 7.1 —Manually Price Pay Items 228
7.4 Bid Adjustments 229
7.4.1 Lock Price 229
7.4 Step by Step 1 — Lock Price 229
7.4 Step by Step 2 —Make Last Minute Bid Adjustments 229

7.4.2 Suspend Pay Items 232
Lesson 7 Review 235
Lesson 7 Summary 235

LESSON 8 — QUOTE MANAGEMENT 237
8.1 Quote Management Overview 239
8.1.1 Quote Management Workflow 239
8.1.2 Quotes and Quote Groups 239
8.1.2.1 Resource Level Quote Groups 240
8.1.2.2 CBS Level Quote Groups 241

8.2 Requests for Quote 241
8.2.1 Request for Quote (RFQ) Register Overview 241
8.2.2 Request for Quote (RFQ) Record 242
8.2.3 Create an RFQ 243
8.2.3.1 Line Items 244
8.2.3.2 Terms & Conditions 245
8.2.3.3 Seller Companies 245

8.2.4 Attachments 246
8.2.5 Setup 247
8.2.6 Publish an RFQ 247
8.2 Step by Step 1 — Create and Publish an RFQ 248

8.3 Quotes 253
8.3.1 Sample Received Quote Scope Sheet 253
8.3.2 Quote Register Overview 254
8.3.3 Quote Record Overview 255
8.3.4 Header Block 256
8.3.5 Price Block 257
8.3.6 Quote Record Tabs 257
8.3.6.1 Resources & Cost Items 257

8.3.7 Data Blocks 258
8.3.8 Data Block Tabs 261

InEight Inc.  |  Release 20.1 Page 9 of 565

Estimate User Guide



8.3.8.2 Special Terms & Conditions 261
8.3.8.3 Qualifications 261
8.3.8.4 Packages 262
8.3.8.5 Taxes 263
8.3.8.6 Seller’s Profile 263
8.3.8.7 Setup 264
8.3.8.8 Minority 265

8.3.9 Create a Quote from RFQ 266
8.3 Step by Step 1 — Create a Quote from RFQ 266

8.3.10 Enter Quote Details 268
8.3 Step by Step 2 — Enter Quote Details 268
8.3 Step by Step 3 — Create a Multi-packages Quote 269

8.3.11 Duplicating an Existing Quote 273
8.3 Step by Step 4 — Duplicate an existing Quote 273

Exercise 8.1 — Quote Management 277
8.4 Quote Comparison & Award 279
8.4.1 Quote Comparison & Award Overview 279
8.4.2 Edit Mode 280
8.4.3 Substitute Values 281
8.4.4 Display Ignored Quotes 283
8.4.5 Additional Quote Comparison and Award functions 285
8.4.6 Configure Totals 286
8.4.7 Adding Notes to Quote Comparison & Award 288
8.4 Step by Step 1 — Add the Notes section to Quote Comparison & Award
form 288

8.4.8 All Quote Groups Layout 290
8.4.9 Compare and Award Quotes 291
8.4.9.1 Open Status 293
8.4.9.2 Award Status 294
8.4.9.3 Review 294
8.4 Step by Step 2 — Compare and Award Quotes 295

8.4.10 Package Entire Quote 297
8.4.11 Incomplete Quotes 298

8.5 Scope Items 299
8.5.1 Scope Item Setup 303
8.5.2 Scope Item Creation and Award 304
8.5 Step by Step 1 — Create and Award Scope Items 304

Lesson 8 Review 317
Lesson 8 Summary 317

Page 10 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



LESSON 9 — REPORTING 319
9.1 Reports Menu 320
9.1.1 Adjustable Reports 320
9.1 Step by Step 1 — Get to Know the Reports Menu 320

9.1.2 Output Settings 323
9.1.2.1 Report Printing Options 323
9.1.2.2 Report Layout Settings 323
9.1.2.3 Report Header/Footer Settings 324
9.1.2.4 Report Detail Settings 325
9.1.2.5 Save Output Settings 326
9.1 Step by Step 2 — Configure Report Output Settings (Report 1) 327
9.1 Step by Step 3 — Configure Report Output Settings (Report 2) 334

9.1.3 Helpful Reports 339
9.1.3.6 PBS Summary 339

9.1.4 Standard Proposal 340
9.1.5 CBS Details 341
9.1.6 Audit 342

Exercise 9.1 — Run a System Report 343
9.2 Register Reports 345

9.2 Step by Step 1 — Create a Register Report 345
9.2.1 Register Report Output Settings 349
9.2.1.1 Page Setup 349
9.2.1.2 Exporting to Document 349

Exercise 9.2 — Create a Custom Register Report 350
Lesson 9 Review 352
Lesson 9 Summary 352

LESSON 10 — DATA REPRODUCTION 353
10.1 Copy an Existing Job 355

10.1 Step by Step 1 — Copy an Existing Job 355
10.2 Templates 356

10.2 Step by Step 1 — Create a Template 357
10.2.1 Archive and Restore Templates 361
10.2 Step by Step 2 — Archive and Restore a Template 361

10.3 Bid Wizard 363
10.3 Step by Step 1 — Use the Bid Wizard 363

10.4 Copy Estimate Data Using Edit Commands 371
10.4 Step by Step 1 — Copy Estimate Data Using Edit Commands 371

10.5 CBS Bid Wizard 375
10.5 Step by Step 1 — Use the CBS Bid Wizard 375

InEight Inc.  |  Release 20.1 Page 11 of 565

Estimate User Guide



10.6 Snapshots 378
10.6.1 Snapshot Register 378
10.6 Step by Step 1 — Snapshot Register 378

10.6.2 Creating a New Job Snapshot 380
10.6 Step by Step 2 — Create a New Job Snapshot 380

10.6.3 Editing a Job Snapshot 383
10.6 Step by Step 3 — Edit a Job Snapshot 383

10.6.4 Deleting a Job Snapshot 384
10.6 Step by Step 4 — Delete a Job Snapshot 384

10.6.5 Loading a Job Snapshot 385
10.6 Step by Step 5 — Load a Job Snapshot 385

Exercise 10.1 — Data Reproduction 387
Lesson 10 Review 391
Lesson 10 Summary 391

LESSON 11 — EXCEL INTEGRATION 393
11.1 Overview 393
11.2 Export to Excel 394

11.2 Step by Step 1 — Export Data to an Excel Workbook 394
11.2.1 Cell Select 395
11.2 Step by Step 2 — Cell Select 395

11.3 Linking to Excel 397
11.3.1 InEight Estimate Workbook 397
11.3.2 Linking to and from Excel 398
11.3 Step by Step 1 — Link Estimate to Excel 399

11.3.3 Update Links 402
Lesson 11 Review 404
Lesson 11 Summary 404

LESSON 12 — SCHEDULE INTEGRATION 405
12.1 Primavera 407
12.1.1 Scheduling Options 407
12.1.1.1 Job Properties Schedule Tab 407
12.1 Step by Step 1 — Login Options Tab 408
12.1.1.2 Mapping Options Tab 409
12.1.1.3 Resources Tab 409
12.1.1.4 Overview – Resources Tab 410
12.1.1.5 Expense Costs Tab 411

12.1.2 Schedule Cost Items 411

Page 12 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



12.1 Step by Step 2 — Schedule a Cost Item in InEight Estimate 412
12.1 Step by Step 3 — Schedule a Group of Cost Items in InEight Estimate 413
12.1.2.6 Roll Up Schedule 415
12.1 Step by Step 4 — Roll Up Schedule 415

12.1.3 Update Primavera from InEight Estimate 415
12.1 Step by Step 5 — Update Primavera from InEight Estimate 416

12.1.4 Update InEight Estimate from Primavera 423
12.1 Step by Step 6 — Update InEight Estimate from Primavera 424

12.1.5 Manage Changes Between Estimate and Schedule 427
12.1.5.7 Plug Days 427
12.1 Step by Step 7 — Schedule Plug Days 427
12.1.5.8 Update Primavera with InEight Estimate Changes 427
12.1 Step by Step 8 — Update Primavera with InEight Estimate Changes 428

Exercise 12.1 —Manage Changes Between Estimate and Primavera 432
12.2 Microsoft Project 434
12.2.1 Set Up Scheduling Options 434
12.2.1.1 Job Properties Schedule Tab 434

12.2.2 Schedule Cost Items 434
12.2 Step by Step 1 — Schedule a Cost Item in InEight Estimate 435
12.2 Step by Step 2 — Schedule a Group of Cost Items in InEight Estimate 436
12.2.2.2 Roll Up Schedule 438
12.2 Step by Step 3 — Roll Up Schedule 438

12.2.3 Update Microsoft Project from InEight Estimate 438
12.2 Step by Step 4 — Update MS Project from InEight Estimate 439

12.2.4 Update InEight Estimate from Microsoft Project 441
12.2 Step by Step 5 — Update InEight Estimate from MS Project 442

12.2.5 Manage Changes Between Estimate and Schedule 443
12.2.5.3 Plug Days 443
12.2 Step by Step 6 — Schedule Plug Days 444
12.2.5.4 Update Microsoft Project with InEight Estimate Changes 444
12.2 Step by Step 7 — Update MS Project with InEight Estimate Changes 444

Lesson 12 Review 447
Lesson 12 Summary 447

LESSON 13 — CASH FLOW 449
13.1 Cash Flow 450
13.2 Cash Flow Options 451

13.2.0.1 Cash Flow Options Set Up 453
13.2 Step by Step 1 — Cash Flow Options Setup 453

13.3 Cash Flow Display Settings 454

InEight Inc.  |  Release 20.1 Page 13 of 565

Estimate User Guide



13.3.1 Cost Items and Cost Categories 454
13.3.1.1 Cash Flow Display Set Up 456
13.3 Step by Step 1 — Cash Flow Display Settings Set Up 456

13.3.2 Resource Utilization 460
13.3.2.2 Resource Utilization Display Set Up 461
13.3 Step by Step 2 — Resource Utilization Display Setup 461

Lesson 13 Review 464
Lesson 13 Summary 464

LESSON 14 — INEIGHT ESTIMATE CALCULATORS 465
14.1 Haul Calculator 466

14.1 Step by Step 1 — Haul Calculator – Calculate Quantity of Trucks 466
14.1 Step by Step 2 — Haul Calculator – Calculate Total Duration 469

14.2 Trench Calculator 470
14.2.1 Trench Calculator – Trench Tab 471
14.2 Step by Step 1 — Trench Calculator – Trench 471

14.2.2 Trench Calculator – Pipe Tab 474
14.2 Step by Step 2 — Trench Calculator – Pipe 474

14.2.3 Trench Calculator – Beddings Tab 476
14.2 Step by Step 3 — Trench Calculator – Beddings 476

Exercise 14.1 — Trench Calculator 479
14.3 In-Field Calculator 482

14.3 Step by Step 1 — In-Field Calculator 482
Lesson 14 Review 484
Lesson 14 Summary 484

LESSON 15 — COST ITEM ASSEMBLIES 485
15.1 Cost Item Assembly Overview 487
15.1.1 Overview 487
15.1.2 Users 487
15.1.3 Navigation / Data Blocks 488
15.1.4 Move Data Blocks 489
15.1.5 Add and Remove Data Blocks 491

15.2 Cost Item Assembly Creation 492
15.2.1 Create a Cost Item Assembly Record 492
15.2 Step by Step 1 — Create a Cost Item Assembly Record 493

15.2.2 Workflow 494
15.2.3 Build Cost Item Assembly Record 494
15.2 Step by Step 2 — Cost Item Assembly Set Up 495

Page 14 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



15.2.4 Cost Items 500
15.2 Step by Step 3 — Create Cost Items in an Assembly 501

15.2.5 Inputs and Tables 503
15.2 Step by Step 4 — Create Input Values 504
15.2.5.1 Data Validation 505
15.2 Step by Step 5 — Create Input Values from a Table 506
15.2.5.2 Standard Tables 510

15.2.6 Conditional Inputs 510
15.2 Step by Step 6 — Set Conditional Inputs 511

15.2.7 Calculations 516
15.2.7.3 Formulas 516
15.2.7.4 Variables 517
15.2.7.5 Functions 518
15.2.7.6 Null Value 518
15.2.7.7 Formula Editor 518
15.2 Step by Step 7 — Create Calculations 520

15.2.8 Notes 526
15.2 Step by Step 8 — Add to the Note Section 527

15.2.9 Linking Calculations to Cost Items 530
15.2 Step by Step 9 — Link Calculations to Cost Items 530

15.3 Cost Item Assembly Employment 536
15.3.1 Employment 537
15.3.2 Job Properties 537
15.3.3 Insert Cost Item Assemblies 538
15.3 Step by Step 1 — Insert Cost Item Assemblies 538

15.3.4 Edit an Employed Cost Item Assembly 541
15.3.5 From the CBS Register 542
15.3 Step by Step 2 — Edit an Employed Cost Item Assembly from the CBS
Register 542

15.3.6 From the Cost Item Assembly Register 543
15.3.7 Advanced Options 544
15.3 Step by Step 3 — Advanced Options 544

15.3.8 Breaking the Link to a Cost Item Assembly 551
15.3 Step by Step 4 — Break the Link to a Cost Item Assembly 551

Exercise 15.1 — Creating and Employing a Cost Item Assembly 554
15.4 Cost Item Sub-Assemblies 555
15.4.1 Accessing the Cost Item Assembly Sub Assemblies 555
15.4.2 Overview of the cost item assembly sub assembly 556
15.4 Step by Step 1 — Creating a Cost Item Assembly Sub Assembly 561

InEight Inc.  |  Release 20.1 Page 15 of 565

Estimate User Guide



Lesson 15 Review 565
Lesson 15 Summary 565

Page 16 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



STEP-BY-STEP PROCEDURES
Step by Step — Launch InEight Estimate 43

Step by Step — Archive and Restore a Job 44

Step by Step — Open a Job Folder 47

Step by Step — Open Forms 56

Step by Step — System Settings 58

Step by Step —Move Columns 59

Step by Step — Sort Columns 61

Step by Step — Filter Columns 61

Step by Step — Filter Editor 63

Step by Step — Group Columns 64

Step by Step — Create a Saved View 66

Step by Step — Create a Labor Resource 86

Step by Step — Create a Rental Equipment Resource 91

Step by Step — Non-Hourly Rate Calculator 93

Step by Step — Create an Installed Material Resource 95

Step by Step — Create a Resource Assembly 99

Step by Step — Create a New Job 107

Step by Step — Set Up Job Level Security 111

Step by Step — Shift Rate Calculator 114

Step by Step — Import Filtered Resources 117

Step by Step — Enter Fuel Costs 118

Step by Step — Create a Pay Item 127

Step by Step — Adjust Take-Off Quantities 139

Step by Step — Create a Subordinate Cost Item 143

Step by Step — Define a Plugged Cost 150

Step by Step — Add Cost Detail 153

Step by Step — Define Cost Detail by Adding an Assembly 157

Step by Step — Adjust Shift Arrangements 163

InEight Inc.  |  Release 20.1 Page 17 of 565

Estimate User Guide



Step by Step — Suspend a Cost Item 174

Step by Step — Unsuspend a Cost Item 175

Step by Step — Add Job Management & Equipment Costs 184

Step by Step — Add General Expense Costs 185

Step by Step — Delete Existing Default Dependent Cost Items 187

Step by Step — Define Prime Bond 188

Step by Step — Define a Price % Add-On 190

Step by Step — Define a Direct Cost Add-On 192

Step by Step — Add User-Defined Indirect Cost Items 197

Step by Step — Add Profit as a Percentage of Target Price 216

Step by Step —Modify the Direct Cost Markup Record 217

Step by Step — Define Pricing Manually 223

7.3 Step by Step 1 — Use AutoPrice to Balance and Hit the Target Total 225

7.3 Step by Step 2 — Unbalance Hit Target Total 225

7.4 Step by Step 1 — Lock Price 229

7.4 Step by Step 2 —Make Last Minute Bid Adjustments 229

8.2 Step by Step 1 — Create and Publish an RFQ 248

8.3 Step by Step 1 — Create a Quote from RFQ 266

8.3 Step by Step 2 — Enter Quote Details 268

8.3 Step by Step 3 — Create a Multi-packages Quote 269

8.3 Step by Step 4 — Duplicate an existing Quote 273

8.4 Step by Step 1 — Add the Notes section to Quote Comparison & Award form 288

8.4 Step by Step 2 — Compare and Award Quotes 295

8.5 Step by Step 1 — Create and Award Scope Items 304

9.1 Step by Step 1 — Get to Know the Reports Menu 320

9.1 Step by Step 2 — Configure Report Output Settings (Report 1) 327

9.1 Step by Step 3 — Configure Report Output Settings (Report 2) 334

9.2 Step by Step 1 — Create a Register Report 345

10.1 Step by Step 1 — Copy an Existing Job 355

10.2 Step by Step 1 — Create a Template 357

Page 18 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



10.2 Step by Step 2 — Archive and Restore a Template 361

10.3 Step by Step 1 — Use the Bid Wizard 363

10.4 Step by Step 1 — Copy Estimate Data Using Edit Commands 371

10.5 Step by Step 1 — Use the CBS Bid Wizard 375

10.6 Step by Step 1 — Snapshot Register 378

10.6 Step by Step 2 — Create a New Job Snapshot 380

10.6 Step by Step 3 — Edit a Job Snapshot 383

10.6 Step by Step 4 — Delete a Job Snapshot 384

10.6 Step by Step 5 — Load a Job Snapshot 385

11.2 Step by Step 1 — Export Data to an Excel Workbook 394

11.2 Step by Step 2 — Cell Select 395

11.3 Step by Step 1 — Link Estimate to Excel 399

12.1 Step by Step 1 — Login Options Tab 408

12.1 Step by Step 2 — Schedule a Cost Item in InEight Estimate 412

12.1 Step by Step 3 — Schedule a Group of Cost Items in InEight Estimate 413

12.1 Step by Step 4 — Roll Up Schedule 415

12.1 Step by Step 5 — Update Primavera from InEight Estimate 416

12.1 Step by Step 6 — Update InEight Estimate from Primavera 424

12.1 Step by Step 7 — Schedule Plug Days 427

12.1 Step by Step 8 — Update Primavera with InEight Estimate Changes 428

12.2 Step by Step 1 — Schedule a Cost Item in InEight Estimate 435

12.2 Step by Step 2 — Schedule a Group of Cost Items in InEight Estimate 436

12.2 Step by Step 3 — Roll Up Schedule 438

12.2 Step by Step 4 — Update MS Project from InEight Estimate 439

12.2 Step by Step 5 — Update InEight Estimate from MS Project 442

12.2 Step by Step 6 — Schedule Plug Days 444

12.2 Step by Step 7 — Update MS Project with InEight Estimate Changes 444

13.2 Step by Step 1 — Cash Flow Options Setup 453

13.3 Step by Step 1 — Cash Flow Display Settings Set Up 456

13.3 Step by Step 2 — Resource Utilization Display Setup 461

InEight Inc.  |  Release 20.1 Page 19 of 565

Estimate User Guide



14.1 Step by Step 1 — Haul Calculator – Calculate Quantity of Trucks 466

14.1 Step by Step 2 — Haul Calculator – Calculate Total Duration 469

14.2 Step by Step 1 — Trench Calculator – Trench 471

14.2 Step by Step 2 — Trench Calculator – Pipe 474

14.2 Step by Step 3 — Trench Calculator – Beddings 476

14.3 Step by Step 1 — In-Field Calculator 482

15.2 Step by Step 1 — Create a Cost Item Assembly Record 493

15.2 Step by Step 2 — Cost Item Assembly Set Up 495

15.2 Step by Step 3 — Create Cost Items in an Assembly 501

15.2 Step by Step 4 — Create Input Values 504

15.2 Step by Step 5 — Create Input Values from a Table 506

15.2 Step by Step 6 — Set Conditional Inputs 511

15.2 Step by Step 7 — Create Calculations 520

15.2 Step by Step 8 — Add to the Note Section 527

15.2 Step by Step 9 — Link Calculations to Cost Items 530

15.3 Step by Step 1 — Insert Cost Item Assemblies 538

15.3 Step by Step 2 — Edit an Employed Cost Item Assembly from the CBS Register 542

15.3 Step by Step 3 — Advanced Options 544

15.3 Step by Step 4 — Break the Link to a Cost Item Assembly 551

15.4 Step by Step 1 — Creating a Cost Item Assembly Sub Assembly 561

Page 20 of 565 InEight Inc.  |  Release 20.1

Estimate User Guide



EXERCISES
Exercise 3.1 — Create Resources & Resource Assemblies 101

Exercise 4.1 — Define Job Properties 122

Exercise 4.2 — Create Pay Items 129

Exercise 5.1 — Create Cost Items 145

Exercise 5.2 — Define Cost Detail 160

Exercise 5.3 —Manage Cost Item Details 178

Exercise 6.1 — Define Indirect Costs 203

Exercise 7.1 —Manually Price Pay Items 228

Exercise 8.1 — Quote Management 277

Exercise 9.1 — Run a System Report 343

Exercise 9.2 — Create a Custom Register Report 350

Exercise 10.1 — Data Reproduction 387

Exercise 12.1 —Manage Changes Between Estimate and Primavera 432

Exercise 14.1 — Trench Calculator 479

Exercise 15.1 — Creating and Employing a Cost Item Assembly 554

InEight Inc.  |  Release 20.1 Page 21 of 565

Estimate User Guide



Page 22 of 565 InEight Inc.  |  Release 20.1

This page intentionally left blank.

Estimate User Guide



InEight Inc.  |  Release 20.1 Page 23 of 565

INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight Estimate
software successfully. As a result, you will be able to build cost estimates and bid proposals with
precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

l Construct and modify cost estimates

l Calculate profit and finalize bid proposals

l Review and report on project information

l Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

l Manage quotes and use additional time-saving tools

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:



Course Lessons

Lesson Topic

Lesson 1 Estimating Core Concepts

Lesson 2 General Navigation

Lesson 3 Library Setup

Lesson 4 Project Setup

Lesson 5 Estimate Direct Costs

Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

Lesson 8 Quote Management

Lesson 9 Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration

Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost Item Assemblies

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the software.
For each step by step, you will use the Training Job that comes pre-loaded in the InEight
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Section Description

Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will use the
Training Job that comes pre-loaded in the InEight Estimate Estimating software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.

Notes are for critical information you need to know.

Ongoing Use

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 1 — ESTIMATING CORE
CONCEPTS

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts

Lesson Topics

1.1 Overview of the Estimating Process 29
Step 1 – Enter Project Details 30
Step 2 – Enter Proposal Deliverables 31
Step 3 – Calculate Direct & Indirect Project Cost 31
Step 4 – Add Markup, Contingency, & Fees 32
Step 5 – Distribute Cost + Markup to required Structure 33

1.2 Key Concepts and Terms 33
1.2.1 Job Folder 34
1.2.2 Library 34
1.2.3 Form 34
1.2.4 Cost Item 36
1.2.5 Pay Item 36
1.2.6 Resource 37
1.2.7 Resource Assembly 37
1.2.8 Cost Item Assembly 38



Lesson 1 Review 39
Lesson 1 Summary 39
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1.1 OVERVIEW OF THE ESTIMATING PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:
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Note the forms used in InEight Estimate to accomplish the steps above:

l Job Properties

l Pay Item & Proposal

l CBS (Cost Breakdown Structure)

l PBS (Price Breakdown Structure)

The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

Step 1 – Enter Project Details

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.
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Step 2 – Enter Proposal Deliverables

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.

• Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

Step 3 – Calculate Direct & Indirect Project Cost

Once you’ve set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost
estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity and is called a cost item
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Step 4 – Add Markup, Contingency, & Fees

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.

Page 32 of 565 InEight Inc.  |  Release 20.1

1.1 Overview of the Estimating Process Estimate User Guide



Step 5 – Distribute Cost + Markup to required Structure

You now have a target price or total estimated value that you can spread to your required project
deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help
automatically distribute your cost, overhead and all markups to the listed items.

1.2 KEY CONCEPTS AND TERMS

To help you get started in InEight Estimate, you should know a few key terms:

l Job Folder

l Library

l Form

l Cost Item

l Pay Item

l Resource

l Assembly
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1.2.1 Job Folder

Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.

When moving back and forth between jobs, make sure to always double-check that you are in the
correct job.

When moving back and forth between jobs, make sure to always double-check that you
are in the right job.

1.2.2 Library

The Library is a storehouse for master data, such as:

• Labor, equipment, and material unit cost rates

• Standard account codes

• Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the
library so you must select which rates to populate a new estimate with. Four tag fields are available to
filter the resource rates you bring into an estimate from the master library. For example, you may
select a subset of your labor rates based on the geographical location of the project.

1.2.3 Form

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:
Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.
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InEight Estimate uses tabs to group and organize entry fields and settings in a logical way,
so that the information is easy to access.

Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

In a register form, you can open a Record for individual items you want to drill into.

The Tab key is the best way to move among fields in InEight Estimate (instead of the
Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.
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1.2.4 Cost Item

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a
cost item.

1.2.5 Pay Item

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
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estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

1.2.6 Resource

Resources are the building blocks of a detailed cost estimate..

Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

1. Labor

2. Construction Equipment

3. Rented Construction Equipment

4. Installed Equipment

5. Installed Materials

6. Supplies

7. Unique

1.2.7 Resource Assembly

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.
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1.2.8 Cost Item Assembly

A Cost Item Assembly is a predefined group of cost items that is costed based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.
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Lesson 1 Review

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:

a. Labor rates

b. Equipment rates

c. Material rates

d. All of the above

3. These are considered the “building blocks” of the job – you employ them to cost items to
develop your estimate.

a. Assemblies

b. Pay Items

c. Resources

d. Forms

Lesson 1 Summary

As a result of this lesson, you can:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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LESSON 2 — GENERAL NAVIGATION

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers

Lesson Topics

2.1 General Navigation 43
2.1.1 Backstage View 43
2.1.2 Overview – Backstage View 44
2.1.3 Open a Job Folder 47
2.1.4 Help Bubbles 48
2.1.5 Data Map 49
2.1.6 InEight Estimate Layout 50
2.1.7 Overview - Setup Tab 50
2.1.8 Overview – Estimate Tab 51
2.1.9 Overview – Quote Tab 52
2.1.10 Overview – Price Tab 53
2.1.11 Overview – Execution Tab 53
2.1.12 Overview - System Tab 55
2.1.13 Library 55
2.1.14 Open Forms 55

2.2 System Settings 57



2.3 Columns 59
2.3.1 Move Columns 59
2.3.2 Sort and Filter Columns 61
2.3.3 Group Columns 64
2.3.4 Saved Views 65

Lesson 2 Review 67
Lesson 2 Summary 67
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2.1 GENERAL NAVIGATION

This section explores the layout of InEight Estimate.

Step by Step — Launch InEight Estimate

1. From the Windows desktop, locate the InEight Estimate shortcut icon.

2. Double click on the icon, or right click and select Open.

If you can’t find the InEight Estimate shortcut icon, you can also launch InEight
Estimate from the Windows Start menu.

2.1.1 Backstage View

InEight Estimate opens to the Backstage view. You can also get to the Backstage view from other tabs,
by selecting the File tab.

Section Description

Section
1

From the Start page you have the option to create, open or save a project, or close all jobs
that are open.

Section
2

You access the Library or open the Jobs page to go to the Job Register, Compare Jobs,
delete a job, or do a Primavera Batch Sync.

Section
3

l Templates allows you to create Job templates.
l You can create job snapshots or access previously created snapshots in the Snapshot

Register.
l You can also archive or back up and restore job folders.

Section
4

Settings allows you to customize options such as General settings, Account Code settings,
Timesheet Warehouse settings, Licenses and Currency settings.

Section From the Open a recent Job section of the Start page, you can open the Training job or click
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Section Description

5 More to open your list of jobs.

Section
6

You have the option of creating a new job from scratch, a template, from an existing job,
or using the Bid Wizard.

2.1.2 Overview – Backstage View

2.1.2.1 Archive / Restore

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature.

Step by Step — Archive and Restore a Job

1. Click File to open the Backstage View.

2. Select Archive / Restore.
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l Several options appear for archiving and restoring your jobs and library

3. Select Archive Job.

l The Job Register appears

4. Select the Training Job, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. To restore the job, select Restore Job Archive from the Archive / Restore page of the Backstage
View.

8. Browse to the archived job and select it.

9. Click Open.

l If the job already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Job Code

2.1.2.2 Settings

From the Settings in the Backstage view, you can adjust some system settings:

l General Settings

l Default Job Start page

l Decimal Precision

l Currency
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l Account Code Settings

2.1.2.3 Prompt to Save

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general
settings.

2.1.2.4 Decimal Precision

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

Changing decimal precision does not affect the way your numbers are calculated.
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2.1.3 Open a Job Folder

From the Backstage view, you can open a job folder by selecting Start. This opens the Start page,
where if you see your job, simply click on it to open it. If it’s not showing, click onMore… and select the
job from the Job Register. The Job Register is the form that lists all of your existing job folders so you
can select the one you need.

Step by Step — Open a Job Folder

1. From the Backstage view, under the Open a recent Job section, double click on the Training
Job.

2. The job folder opens by default to the Cost Breakdown Structure Register.
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You can change the default form that opens when you start up a job. From the Backstage view,
click on Settings to change the Job Startup > Start Page settings.

2.1.4 Help Bubbles

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.
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You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.

2.1.5 Data Map

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect
costs, profit, and overall bid price.
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2.1.6 InEight Estimate Layout

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2.1.7 Overview - Setup Tab

Section Description

1 Initialize

From the initialize section, you can access the following registers. Job Properties is
where you enter the basic project details. Foundation Setup Data is where you
populate all account codes and validated fields. The Pay item & Proposal Register
provides an alternate structure to distribute estimated values. Bid Wizard helps
automate the process of setting up estimates by copying information that already
exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate Register,
where detail costs for labor, equipment and material is stored. The Resource
Assemblies opens the Resource Assembly Register, where you create a
combination of resources as an assembly and reuse it as needed in multiple cost
items.

3 Assemblies
You can create a Cost Item Assembly to automatically estimate different scopes of
work based on input values. Standard tables – allow you to create tables of
reference data that can be accessed in any cost item assembly.

4 Reports The Reports section is available from any tab. Depending on the tab you access it
from will bring you to reports specific to that tabs data. Here you will find reports
on resources such as Resources Changes, Resource Utilization, and Resource Cost
Details.
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2.1.8 Overview – Estimate Tab

Section Description

1
Breakdown
Structures

From the Breakdown Structures section in the Estimate tab you can access the
Cost Breakdown Structure (CBS) Register, Account Code Utilization Register, and
Work Breakdown Structures (WBS) Register.

2 Resources Resource Rate Register is where you create or modify the rate charged for labor,
material and equipment resources. Different views of the Resource Rate register
such as Resource Utilization and Resource Cost Details are available from the
Resources section.

3
Excel
Workbook

InEight Estimate's integration with Microsoft Excel is a two-way integration that
allows you to update register fields in Estimate with data contained in an Excel
workbook, and update Excel cells with data contained in a register field in
Estimate. This is where you open the embed excel workbook which is maintained
as part of the estimate job folder and where you preform the sync functions to
send values back and forth.

4 Schedule From the Schedule icon, you can access bi-directional integration with Microsoft
Project and Oracle Primavera. The Cash Flow graph displays the projected cash
flow of your project, along with the job financing expense, individual cost
category costs and resource utilization.

5
Indirect
Cost Items

Indirect Cost Items filters the CBS register to display cost items that contain
overhead costs that are not directly associated with any particular deliverable
items. Clicking on % Price Add on or Prime Bond opens up these individual records.

6 Overhead
and Profit

Price Breakdown Structure (PBS) Register is a visual run-down of the costs and
profit that make up your Target Price. You can access the Direct and Indirect
Markup records or see totals of direct costs, indirect costs, profit and overall bid
price summarized in a Data Map.

7 Alternates Alternates are used to define alternate scenarios in order to assess the impact of
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Section Description

those scenarios.

8 Reports From the Reports section, you can run reports on CBS Summary, CBS Details, CBS
Outline, CBS Estimate Summary, CBS Currency Comparison.

2.1.9 Overview – Quote Tab

Section Description

1 Setup

Quotes are organized using Address book, Quote Group Tags, Minority Setup
and attachments in the Setup section. Address book stores and maintains all
information pertaining to subcontractors, vendors, architects/engineers, etc.
that you work with regularly. The Minority Setup tab within Job Properties
stores information about the agency that authorizes the status of Minority
Enterprises along with their different types. You can use Quote Group Tags to
group together multiple resources or cost items that will be sent in a single
request for quote package to solicited contractors or vendors..

2 Quote
Management

Quote Management allows you to access the Requests for Quote (RFQs)
register and Quotes. Request for Quotes (RFQs) are invitations to sellers,
requesting that they submit pricing to provide services, equipment or material
based on the line items and resources included in your estimate. The Quote
Register stores all of the quote responses you receive for that job.

3
Quote
Comparison
& Award

The Quote Comparison & Award section allows you to perform comparative
analysis across all the quotes you’ve received. You can view a comparison of
submitted pricing by resources or cost items.
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Section Description

4 Reports From the Reports section in Quotes you can run reports on Quote Summary,
Quote Record, Compare & Award, and Minority Participation.

2.1.10 Overview – Price Tab

Section Description

1 Pay Items

From the Pay Items section you can lock Cost items to Pay items and access the
Pay item & Proposal register. Under Pricing in Job Properties, you can set up how
the tool is calculates profit and spreads pricing to your pay items. You can also
access Competitor’s bid information in Job Properties..

2 Overhead
and Profit

The Price Breakdown Structure (PBS) Register is a visual run-down of the costs and
profit that make up your Target Price. You can access the Direct and Indirect
Markup records or see totals of direct costs, indirect costs, profit and overall bid
price summarized in a Data Map.

3 Audit Log
You can access the PBS Changes register (which logs any changes that effect the
Target Price) and turn on/off logging PBS changes..

4 Alternates Alternates are used to define alternate scenarios in order to assess the impact of
those scenarios on the total estimate value.

4 Reports From the Reports section in the Price tab, you can generate reports for Standard
Proposal, DOT Proposal, Pay Item Summary, Pay Item Currency Comparison, Pay
Item Price Breakdown.

2.1.11 Overview – Execution Tab

The Execution Tab is for Customers who are utilizing the Job Tracking functionality within InEight
Estimate. InEight Control users can disregard this tab.
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Section Description

1 Job Tracking

You can customize the titles and colors for
different fields. You can export and import
saved Views, Titles, Colors and Output Settings.
You can customize reports generated by
Estimate using External reports. External
References allows you to open external
programs with Estimate.

2 Overhead & Profit Commitments tracks how much of the current
budget has been committed for expenditure.
Pay Requests and Approvals automatically
calculates earned revenue to provide the data
you need to bill your client, as well as approve
invoices from your suppliers and
subcontractors.

3 Change Management

Budget/Contract Changes is the only way to
change current budget or add a pay item after
the project has been released for execution
and the Original Budget locked. Create
Original & Current Budget sets the original and
current budget for the project. These should be
equal when you initially create it (at the
beginning of project execution). Current
budget is the only thing that can change after
execution. Remove Original & Current Budget
removes original and current budget values.

4 Reports and Exports From the Reports icon, you can run multiple
reports on the project. Exports can export
budget file, schedule, and timesheet to many
different formats.
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2.1.12 Overview - System Tab

Section Description

1 Custom

You can customize the titles and colors for different fields. You can export and import
saved Views, Titles, Colors and Output Settings. You can customize reports generated
by Estimate using External reports. External References allows you to open external
programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can get
information about the Estimate Version and all new updates about the different
versions.

2.1.13 Library

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.

The Library is covered in greater detail in "3.1 Library Overview" on page 71

2.1.14 Open Forms

The following steps assume you already opened the Training Job.
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Step by Step — Open Forms

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties and
select Overview to open the Job Properties form.

l Notice that each form opens in its own tab within the active job folder

l You can tab between these forms as you are working in InEight Estimate

l Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register
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2.2 SYSTEM SETTINGS

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

l General settings (options)

l Network settings

l Attachment settings

l Licensing information and settings

l Currency settings

The following step by step walks you through configuring general settings (options).
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Step by Step — System Settings

1. With InEight Estimate open, click on the File tab to go to the Backstage view.

2. Select Settings

3. Select General under Options in the node tree on the left.

4. To activate Prompt to Save, select the Prompt to Save checkbox.

5. Select how often you want to be prompted (in minutes).

6. Select Decimal Precision in the tree on the left.

7. Review the default settings.

Units of Measure will default to English, and Currency will default to U.S. Dollar.
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2.3 COLUMNS

Within each register, you can move, sort, filter and group your columns to view the information the
way you need to see it.

2.3.1 Move Columns

You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.

Step by Step — Move Columns

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.
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l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to go.
In this case, drag the Optional Code and drop it to the right of the Currency column.

l You can also unhide a column using the Go To Column feature

4. Right click on a Column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.
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6. Click OK.

2.3.2 Sort and Filter Columns

You can sort and filter your columns to drill down to specific information.

Step by Step — Sort Columns

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

l Cost Item 14 – Process Equipment should now be at the top of the list

Use Ctrl-click to unsort a column and reset it to its original state.

Step by Step — Filter Columns

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.
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l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).

3. Select Ton, then click OK.

l The register now only shows items that have the Ton unit of measure; a description of the
filter, along with a red X, is found at the bottom of the form

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.

2.3.2.1 Filter Editor Overview

The Filter Editor displays conditions and groups as a tree branching system.

The Filter Editor grouping feature allows you to increase the amount of And/Or statements that
originated from the first selected And statement. When you add a new Group, a new Condition is
automatically added to that Group.
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With each additional Condition statement, you will need to select an operator and a value in order for
your customized filter to take effect on your chosen column. Many new operators have been added to
this version as shown in the screenshot below:

Step by Step — Filter Editor

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click the filter icon in the Unit of Measure column to select a filter value.

3. Select the Filter Editor button. The Filter Editor data box appears.

l By default, an And statement is created with a Begins with operator and a blank value.

4. Select your preferred operator and then enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop down
appears.
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6. Choose which And/Or statement to add and then select the preferred operator.

7. Enter in your preferred value to complete your additional statement.

8. Select the X to delete a single statement.

9. Select the And statement in the top left corner to begin clearing all And/Or statements.

10. From the drop down, select the option Clear All.

11. Once done, select Apply and then click OK.

2.3.3 Group Columns

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

Step by Step — Group Columns

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).
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l Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.

2.3.4 Saved Views

Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Viewsmenu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future
use.
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Step by Step — Create a Saved View

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

2. Click on the Save disc icon.

l The Save Current View window appears

3. Enter the View Name, then select OK.

l The new view displays in the drop-down menu

Saved views are user-specific; you will only see your own saved views when you are
logged in.
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Lesson 2 Review

1. The _________ is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.

a. Job Folder

b. Data Map

c. System tab

d. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.

1. True

2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
_______ tab.

a. Setup

b. Estimate

c. System

d. Help

Lesson 2 Summary

As a result of this lesson, you can:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers
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LESSON 3 — LIBRARY SETUP

Lesson Duration: 60 minutes

Lesson Objectives

After completing this lesson, you will be able to use the following forms and explain their purpose:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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3.1 LIBRARY OVERVIEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click on the Library link to open.

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.

InEight Inc.  |  Release 20.1 Page 71 of 565

Estimate User Guide 3.1 Library Overview



When the Library opens, you see ribbons available under the main menu tabs. Each Menu tab has
unique sections which hold the necessary forms. In this lesson you will learn about each tab and their
components.

3.1.1 Library Tabs

The Library has six tabs which organizes the forms under sections. The tabs are:

l Setup

l Estimate

l Execution

l System

The Actions and More Actions tabs appear when you open a register and contain functions for the
register you have active.

3.1.1.1 Setup Tab

Name Description

1
Job
Properties

The job properties maintained in the library will serve as the default settings for
any new estimate that is created from scratch. When creating a new job it will
inherit all the job properties set in the master library.

2 Foundation
Setup Data

A master set of account codes, tags, and units of measure. When a new folder is
created, the master set is automatically copied from the Library to the new folder.

3
Address
Book

Used to store and maintain all information pertaining to the companies with whom
you work and contact regularly (subcontractors, vendors, architects, etc.).

4 Trench
Calculator

Stores and maintains common trench configurations that are used from project to
project.

5
Shift Rate
Calculator

Allows you to set up shift rate configurations that you can access at the project
level.

Overview - Setup Tab
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Name Description

6 Resource
Rates

Opens the Library Resource Rate Register where you can create and edit all
resources and resource cost details available for import into your projects.

7
Most Used
Resources

For quick access to the Labor, Equipment and Materials tabs of the Master
Resource Rate Register.

8 Resource
Assemblies

Takes you to the Library Resource Assembly Register where you can set up
resource assemblies to import into individual projects.

9
Cost Item
Assemblies

Cost Item Assemblies are predictive models to quickly and accurately estimate
elements of a job that can be repetitive in nature on the job or from job to job.

10 Standard
Tables

The Standard Tables are used to create and/or list job-level table data that is
accessible by any of the Cost Item Assemblies that exist in a job. The Standard
Table Record allows the user to create and or modify a Table record. The
Standard Table Register lists all the job level tables created / available in the
project.

11 User Roles

Opens the Register where you assign users to a role which can include the forms,
tabs and menu commands to which each role has access. The user names that are
used when setting up your User Profiles come from Active Directory, and they are
the user names that each user uses when logging onto his/her personal computer.

12 Access
Control

Allows you to customize your system permissions by restricting destinations or
commands that only designated roles should have access to.

13 Reports
Opens the Reports window, where you can access all system reports and configure
the default report settings.

Overview - Setup Tab (continued)
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3.1.1.2 Estimate Tab

Name Description

1

Cost
Breakdown
Structure
(CBS)

Opens the Library Cost Break Structure register, where you can define the CBS that
will automatically import when a new project is created.

2 Account
Code
Utilization

Used to roll estimate line items into an account code hierarchy and benchmark
against historical projects in a way that is consistent across projects.

3
Work
Breakdown
Structures

Opens the Library Work Break Structure register, where you can define additional
Work Breakdown Structures that will automatically import when a new project is
created.

4 Master
Workbook

Opens the master Microsoft Excel template which will be embed into each new
estimate job folder. The cells in the embed excel workbook can be linked to send
information to or from InEight Estimate Fields.

5
Indirect
Cost Items

Takes you to the Library Cost Breakdown Structure Register where you can edit
and define indirect cost items.

6 Job
Finance

Takes you to the Library Cost Breakdown Structure Register where you can edit
the Job Financing cost item.

7
Price % Add
On

Takes you to the Price % Add On record, where you can define the price % add to
be included in the Library CBS.

8 Prime
Bond

Opens to the Library Prime Bond record where you can define the bond tables that
will import automatically when a new project is created. 

9 Reports
Opens the Reports window, where you can access all system reports and configure
their report settings.

Overview - Estimate Tab

Page 74 of 565 InEight Inc.  |  Release 20.1

3.1 Library Overview Estimate User Guide



3.1.1.3 Execution Tab

Name Description

1
Timesheet
Warehouse

Used to document for any period of time (day, week, month, etc.) the employees
and machines employed on a cost item (tracked by Account, Phase or CBS Code),
how many hours they are employed and optionally, the quantity of work they
accomplish.

2 Publish Jobs
for
Timesheet
Warehouse

Links to the Job Register to publish jobs from the Timesheet Warehouse.

3

Unpublished
Jobs for
Timesheet
Warehouse

Opens up a list for to view the unpublished jobs from the Timesheet Warehouse.

4 Published
Jobs

Opens to a Register to show the published jobs from the Timesheet Warehouse.

4
Employees &
Machines

Opens a register which list all of your company's employees and machines,
including their identification number and other associated codes.

5 Reports Opens the Reports window, where you can access all system reports and
configure their report settings.

Overview - Execution Tab
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3.1.1.4 System Tab

Name Description

1 Customize
Window to customize the field titles that are displayed throughout various screens
in the system, including all cost category titles, user-defined Tags, and more.

2 Saved
Views

Allows you to save your views onto a disk or load from a disk. 

3 Titles Allows you to save titles onto a disk or load from a disk. 

4 Colors Allows you to save your colors onto a disk or load from a disk.

5
Output
Settings

Allows you to save your output settings onto a disk or load from a disk.

6 External
Reports

Menu to not only generate reports created by Estimate, but also to open programs,
folders, documents, reports, or Internet resources with the associated program.

7
External
References

Allows you to open programs, folders, documents, reports, or Internet resources
with the associated program.

8 Help
Section

Offers you links to Estimate’s general Help menu, information about Estimate (i.e.,
version number, system information, tech support, etc.), What’s New in the new
version, and InEight’s external website.

Overview - System Tab

Page 76 of 565 InEight Inc.  |  Release 20.1

3.1 Library Overview Estimate User Guide



Customized Job Folder Tags match the view of the fields in the Job Properties form.

3.2 LIBRARY JOB PROPERTIES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

l Overview Tab Notes Field:  Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

l Cost Basis Tab:  Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

l Fuel Cost Tab:  Entering a default fuel cost here will factor with the utilization of your equipment
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to be included in your equipment rates

3.3 LIBRARY FOUNDATION SETUP DATA

Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

You should be aware of these category labels:
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Category Labels

Name Definition

Account
Codes

These codes will be set up on the back end and will help you compare your cost and
production rates to similar cost items in past projects.

Tags
Some tags are already set up for you. Additional tags can be created and used to group
and filter your items.

Work
Breakdown
Structures

Use this format when you need to have multiple variations and summary reports of an
estimate. WBS retains the same relationships between items as in the original estimate
and only changes the view and how items are arranged in hierarchy.

Units of
Measure

These are standardized to relate to one another by a conversion factor. If you need to
create a new unit of measure, you will need to reference it to a base unit of measure
and can include a conversion factor to allow you to convert back and forth between
English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange rate for
other currencies (such as Canadian) so you can estimate with whatever currency you
need. Multiple currencies can be used in the same project. The system base currency
can be changed from USD in the backstage view settings, but is a global change for the
entire estimate environment.

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

3.4 RESOURCES

InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:
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Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is typically
classified by trade (e.g., pipefitters, electricians, iron workers) and title (e.g.,
foreman, journeyman, laborer).

Construction
Equipment

Owned construction equipment.

Rented
Construction
Equipment

Construction equipment rented from a third party.

Installed
Materials

Materials that will remain installed on site after the project is completed, (e.g.,
concrete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed, (e.g.,
boilers, heat exchangers, vessels, cooling towers).

Supplies
Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types (e.g.,
dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the
new project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

3.4.1 Library Resource Rate Register

To open the Library Resource Rate Register, select Labor from the Master Resources ribbon.
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Overview – Library Resource Rate Register

Name Description

1 Tabs
There are tabs along the top of the form for each of the seven resource types, in
addition to an All tab that holds the resources of all types.

l Notice that you are on the Labor Tab

2 Resource
Code

Each record (or row in the register) represents a single resource.

3 Description The Description provides more detail about the resource.

4 Resource
Rate per
Unit

This is the resource cost per unit.

5
Utilization
Count

Tells you how many units of that resource are being used in the job.

6 Unit of
Measure

Each resource is defined with a Unit of Measure.

7 Register
This register includes columns for the resource attribute categories so you can
filter and group your resources.
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Resource rate add and search tips:

l You cannot add new resources on the All tab.

l You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how the differ when we drill into
resource rate records from each category.

3.4.2 Labor Resources

Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you
can also use another organizational method of your choice.

3.4.3 Resource Rate Record

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.
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Overview – Resource Rate Record

Name Description

1 Record The record references the resource you are editing.

2 Charge
Rate

The Charge Rate tab is the tab the record defaults to and is where you define the
cost of the resource.

3
Scale
Buttons

The Scale buttons only show up on labor resources. They are used for defining
regular time, overtime and double time rates for the resource.

4 Cost
Category
Breakdown

The Cost Category Breakdown is where you enter the costs for the resource. The
categories will depend on what type of resource it is (e.g., equipment resources
will have equipment cost categories and materials will have material cost
categories).

5

Special
Instructions
/ Base
Wage
Factors

The right side of the record will have additional options to help you define the
rate. These options change depending on what type of resource it is.
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Name Description

6 Setup
There is also a Setup tab where you can define the resource’s attributes an a few
other settings. These attributes are used for filtering which resource rates to load into
a new estimate.

7 Cost
Driver

Labor resources default Cost Driver is CI Duration which means their costs are driven
by time.

8
Default
Quantity

The Default Quantity is typically set to 1 for most cases if you are bringing in the
resource you are using at least one.
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The following steps walk you through how to create a new labor resource.

Step by Step — Create a Labor Resource

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

l The Library Resource Rate Register opens

2. Select the Labor tab.

3. Right click on any row header and select New.

l A new Labor Rate Record displays

4. In the Code field, type LMECH [your initials].

5. Press the Tab key.

6. In the Description field, type Mechanic - Heavy Duty.

7. Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select Southwest for the Geographic Area.

9. SelectWage Zone A for Wage Zone.

10. SelectMechanic in the Organizational Category.

11. For Tag 2, select Non-Union.
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12. For Tag 1, select Hourly.
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13. On the Charge Rate tab, enter $52.00 for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type $3.00 for Pension and $2.00 for Subsistence.
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15. You need to define an overtime and double-time rate for the resource. Select the checkbox for
Use Base Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.

17. Click OK, to close the record.
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3.4.4 Construction Equipment Resources

l Similar to Labor Resources, Construction Equipment Resources are also duration driven
resources by default

l They contain cost categories for ownership and operation costs

These resources are the fleet of construction equipment that you own.

3.4.5 Rented Equipment Resources

These resources represent the construction equipment that you rent.

l Rented Equipment Resources are also duration driven resources by default

l Contain cost categories for rental and operation cost as well as additional fees

l On the Rental Construction Equipment Record, you will notice a new tab named Quote

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls the
Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually specify
a unique sales tax rate
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Step by Step — Create a Rental Equipment Resource

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR110 [your initials], then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.
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7. Select Crane from the Organizational Category drop-down list.

8. Move back to the Charge Rate tab to follow the step by step on the next page.

3.4.6 Equipment Consumption Rates

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel
Cost tab to give a fuel cost for your equipment rate.

The below figure shows where consumption rates are defined on the Construction Equipment Resource
Rate Record.

Page 92 of 565 InEight Inc.  |  Release 20.1

3.4 Resources Estimate User Guide



3.4.7 Non-Hourly Rate Calculator

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

Step by Step — Non-Hourly Rate Calculator

1. The rate for your RECR110 Crane 110 Ton resource is $4000 per week. Under Non-Hourly Period
Charge Rates on the right, check the Calculate Non-Hourly Period Charge Rates checkbox.

2. On the resulting prompt, click OK.

3. In the Period field, selectWeekly.

4. In the Amount Per Period field, type 4000.

5. Type 20 in the Hours Per Period field.
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l Your hourly Owned Equipment rate will auto-fill with $200.00

6. Click OK to close the record.

3.4.8 Installed Materials, Installed Equipment & Supplies Resources

l Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
quantity-driven resource, as opposed to duration-driven like your labor and equipment resources

l You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

l On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l In the Setup tab you will see a field named Waste % Add-on. Here you can account for
approximate waste percentages

l Cost categories will differ on each type of resource record
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Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

Step by Step — Create an Installed Material Resource

1. Select Resource Rates from the Library landing page.

l The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right click on any row header and select New from the drop-down menu

l A new Installed Material Rate Record displays

4. In the Code field, type MGBP [your initials], then press Tab.

5. In the Description field, type Brick Pavers.

6. Select Square Feet from the Unit of Measure drop-down list.

7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.
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8. On the Charge Rate tab, expand Materials and type 5.00 in the Installed Materials Amount field.

9. Click OK to finish adding this resource.

3.4.9 Unique Resources

The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

l The Unique resources are the only resources that have all cost categories available, as well as all
units of measure

l You will also note the tax field which can pull your standard tax settings from the Cost Basis tab
in Job Properties, or a unique sales tax rate can be manually entered in each record

l Quotes will be discussed in detail in Lesson 8 – Quote Management
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3.5 RESOURCE ASSEMBLIES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3.5.1 Library Resource Assembly Register

To open the Library Resource Assembly Register, select the Library icon, then select Resource
Assemblies from the Master Resources section of the Setup tab.

Overview – Library Resource Assembly Register

Section Description

1
Each row in the register represents a single resource assembly and is defined with an
Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus icon next to its Assembly Code.

3

Expanding an assembly reveals the list of resources that make up that assembly.
l Best practice for creating Assembly codes is to use C for Crew Assemblies, M for

Material Assemblies, etc., however you can have labor, equipment, and materials in
the same assembly
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3.5.2 Resource Assembly Record

To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

Overview – Resource Assembly Record

Name Description

1
Assembly
Code and
Description

Each assembly is defined with an assembly Code and an assembly Description.

2 Quantity
and Unit
of
Measure

Each assembly has a quantity and unit of measure. The default is 1 EA. For crew
assemblies with all hourly duration driven resources, it is a best practice to change
the Qty to Hour, so that when used on a cost item, it will show you the assembly’s
unit cost per hour.

3
Assembly
Details

The rows in the Assembly Details register represent the resources that make up the
resource assembly.

4 Notes An area where the estimators make notes for records related to the resource
assemblies for work or productivity rates which is commonly performed by a type
of crew.
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Step by Step — Create a Resource Assembly

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

l The Resource Assembly Register displays

2. Right click on any row header and select New from the drop-down menu.

l A new Resource Assembly Record displays

3. In the Code field, type CEXC [your initials] as the unique code for the assembly.

4. In the Description field, type Excavation Assembly.

l This field is an expanded clarification of the assembly Code

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add the following additional resources:  L02 - Operator Class 2 and EX225 - Excavator.

l Once you’ve added resources, you can indicate how many of them you want in the
assembly. In this case, leave the quantities of the assembly resources at 1

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.

l The new assembly now appears on the Library Resource Assembly Register
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Exercise 3.1 — Create Resources & Resource Assemblies

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library.
In the Library Resource Rate Register, create resources with the following variables:

Resource Code LSFA Wage Zone Wage Zone A

Resource Description Field Administrator Organizational Category Supervision

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47

Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Labor Resource

Rented Construction Equipment Resource

Resource Code RPW3000 RE Rental Amount $3.40

Resource
Description

Pressure Washer 3000 PSI
Organizational
Category

Clean & Inspect

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code MCCB Installed Materials Amount $300.00

Resource
Description

Pre-Cast Concrete Catch
Basin

Organizational Category Concrete

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%

Rented Construction Equipment Resource

In the Library Resource Assembly Rate Register, create resource
assemblies with the following codes, descriptions, and resources
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Assembly Code CBRIDGE

Assembly Description Bridge Crew

Resource File Standard Assembly File

Unit of Measure Hour

SelectWage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LC3 Carpenter Foreman 1

LL2 Laborer 2

LF2 Finisher 1

LC2 Carpenter Journeyman 2

Assembly #1

Assembly Code CRIPRAP

Assembly Description Rip Rap Replacement Crew

Resource File Standard Assembly File

Unite of Measure Hour

SelectWage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LT2 Teamster Foreman .5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1

ETPU Pickup 1

EL950 Loader 950 1

Assembly #2

You should end up with the following results
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Congratulations, you have completed this exercise!
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Lesson 3 Review

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True

b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

c. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data

b. Library Resource Rates

c. Job Properties

d. Cost Breakdown Structure

Lesson 3 Summary

As a result of this lesson, you can define, adjust and explain:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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l Create a new project

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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4.1 JOB CREATION

As discussed in Lesson 1, a job folder contains all pertinent information for a single project, and it is
independent from any other job. When you create a new job folder, all your estimating and managing
of the project will be stored in that folder.

First, you will create a new job from scratch.

Step by Step — Create a New Job

1. From the InEight Estimate Backstage view, under the Create a new Job from… section, select
Scratch, or select New > Scratch from the left sidebar menu.
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2. On the New Job dialog, type E101 - Training Job (with your initials)in the Code field.
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l The Job Code must be unique to differentiate between projects

3. Type Sample Training Job in the Description field.

l The Description field is usually a longer title and helps you identify the project

l It is not required, but best practice is to have a good description to make it easier to find
the job

4. Click OK to create the new project.

l The project is created and the Job Properties form for the new project automatically
displays

4.2 JOB PROPERTIES

When you create a new project, the Job Properties form automatically displays. This is where you can
enter basic information about the project. To open the Job Properties form at any other time, on the
InEight Estimate landing page, select the Setup tab and click Job Properties.

4.2.1 Overview Tab

The Job Properties form opens to the Overview tab.

Name Description

1 Job Code and Contain the information you entered on the New Job dialog.

Overview – Overview Tab
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Name Description

Description
l The Description can be changed at any time if necessary
l The Code cannot be changed

2 Status Indicates where in the process this project is (e.g., Bidding, Awarded, etc.)
• When searching for jobs in the Job Folders list, you can filter and sort jobs
by their status
• These job statuses can be adjusted to fit your company requirements in the
Jobs Register, Tools Menu, Job Statuses.

3 Notes
Used to document project specifics.

l Information in this field is created in InEight Estimate and it is not
integrated with other programs

Overview – Overview Tab (continued)

You can change your Job Code by making a copy of the job with a new code.

4.2.2 Security Tab

When you set up the job, you can secure it so only those working on the estimate will have access. You
can adjust security at the field level or at the job level.

The following steps walk you through how to set up security. For now, you will leave the Security tab as
is without making any specific selections; however, the following steps guide you through making any
security changes when needed in the future.
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Step by Step — Set Up Job Level Security

1. On the Job Properties > Security tab, select the Restrict access to this Job… check box.

l Notice the checkbox to “Allow ALL users with Bid Wizard access to use this job as a source”
is checked by default. Make sure to keep this checked

2. Click the Add Users / Groups button to add users.

3. In the Select Users or Groups dialog, type the email addresses for those that need access and
then click OK.

l If you don’t know the email address, you can type the name of the user, and click the
Check Names box to find the appropriate user.

l The job can now only be opened by those listed under Users allowed in this job

4.2.3 Cover Sheet Tab

The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:

l Job Location

l City, County, Country, Province/State

InEight Inc.  |  Release 20.1 Page 111 of 565

Estimate User Guide 4.2 Job Properties



l Job Type

l Engineer

l Owner

l Architect

l Forecast Start and Forecast Finish

l Bid Date and Bid Time

l Bid Location

l Estimator

l Opening Type and Proposal Type

l Liquidated Damages (if applicable)

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

4.2.4 Cost Basis Tab

The Cost Basis tab has some important settings that will affect how costs are calculated in your
estimate. The settings reviewed below are the ones you need to consider.
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Name Description

1
Standard Shift
Arrangements

The default standard shift arrangements are set up as 8 hours per shift, 1 shift
per day, and 5 days per week; this can be changed if a project requires a
different standard shift arrangement.

2 Standard
Wage Rate
Composite:

Allows you to indicate what percentage of your labor hours will be regular time
(Scale 1), overtime (Scale 2) or double time (Scale 3). You can enter these
percentages manually, or you can use the Shift Rate Calculator to obtain a more
accurate figure.

3
Lock Cost
Items to Pay
Items:

For this sample job, you will check this box. When Cost Items are locked to Pay
Items, your level 1 estimate structure is controlled by your list of pay items.

4 Default
Currency:

The default will be set to U.S. Dollar, but this can be changed if needed.

5
Sales Tax
Rate:

This field is not required but may be used to automatically apply a sales tax to
all your material and rental items. The default is set to zero.

Cost Basis Tab Overview

4.2.5 Shift Rate Calculator

Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.
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Step by Step — Shift Rate Calculator

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. You can enter up to three shifts for the project. For Shift 1, type 10 hours in the Monday through
Friday Work Hours fields.

l Scale 1 will be your regular time and Scale 2 will be your overtime

3. For Shift 1, type 8 hours in the Scale 1 fields and 2 hours in the Scale 2 fields (just Monday
through Friday).
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l You should now have the following for Shift 1:

4. For Shift 2, enter the following:

5. Click OK.

l Now you have a blended shift arrangement, and your labor rates are a blend of 64.18%
straight-time and 35.82% overtime

6. Now that you have worked through an example, change the shift arrangements back to the
default standard shift arrangements of 8 hours per shift, 1 shift per day, and 5 days per week and
the standard wage rate composite should be set back to the default of scale 1 set to 100%.
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4.2.6 Import Filtered Resources

You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use it
to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.

You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources
you need.

Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File
Description

This attribute can be used to designate the rate type or the year to which the rates
pertain.

Geographic
Area

This attribute is used to designate regions, cities, or provinces based on geographical
location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example, it may
designate the trade and union agreements your labor resources belong to.
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Resource Attribute Filters

Organizational
Category

This attribute can be used to designate what trade or work type your resources
pertain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.

Step by Step — Import Filtered Resources

1. In the E101 - Training Job, on the Job Properties > Cost Basis tab, select the Labor Rate
resource type.

2. Under Resource File Description, select Standard Labor Rate File.

3. For Geographic Area, select Southwest.

4. For Wage Zone (Work Center), selectWage Zone A.

5. For Organizational Category, select All.

6. Select the Construction Equipment resource type.

7. Select the Standard Labor Rate File for the Resource File Description, leaving the Geographic
Area, Wage Zone, Organization Category set at All.

8. Do the same for the remaining resource types (including Assembly).

9. Select the Import Filtered Resources button to bring your selected resources into the job.
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You must select “Import Filtered Resources” to import your resources. Clicking OK on the
Job Properties form will not import your resources.

4.2.7 Fuel Cost Tab

On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

Step by Step — Enter Fuel Costs

1. In E101 – Training Job, open the Job Properties > Fuel Cost tab.

2. Under Cost Per UM enter the following:

l Diesel:  $4.20

l Gas & Gasoline:  $3.90

l Off Road Diesel:  $3.20

3. Currency should read U.S. Dollar and UM should read Gallon.

l In this example, if the gasoline cost per gallon is $2.80 and your truck consumes 3 gallons
per hour, you will have an hourly fuel cost of $2.80 X 3 or $8.40
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4.2.8 Job Folder Tags Tab

On this tab, you can enter tag fields to label your project, so you can reference it later.

Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.

4.2.9 Schedule Tab

The Schedule tab is used to define the scheduling options for the integration between InEight Estimate
Primavera or Microsoft Project. The settings you define here determine what information is sent to
your scheduling tool, and how it will be structured.

l At the top of the Schedule tab, the Integrated Schedule can be set to Primavera or Microsoft
Project or Manual

l You will need to confirm the proper settings are defined on each of the Schedule sub-tabs. These
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settings are defined in detail in Lesson 12 – Schedule Integration

4.2.10 Other Job Properties Tabs

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.

Other Job Properties Tabs

Name Function

Minority
Setup

Used to set up minority participation goals (for example, DBE or MBE) and you want
to track minority participation goal attainment status during the bid process,

Job Tracking

Used to select the code that will be used when tracking job progress, define the
planned production calculation, define the percent complete calculation, define the
forecast methods, and define markup rates for calculating earned revenue on Time
and Expense pay items.

Competitors For an estimate that is being submitted for a competitive bid, this is a place to track
a list of competitors and if available, store competitor price submissions for
reference and trend tracking.

Pricing
Used to define how you want the Balanced Unit Price for each of the job's pay items
to be calculated when using the AutoPrice feature

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation of Job
Financing and cost/revenue realization to generate the curves that display on the
Cash Flow form.
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Other Job Properties Tabs

Equipment
Maintenance

Used to define the calculation of maintenance labor man-hours based on equipment
utilization, to capture the impact on total man-hours when changes are made that
affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current job,
and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
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Exercise 4.1 — Define Job Properties

In this exercise, you will continue to define your Job Properties from in the E101 training job you
have created. Complete the following steps:
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1. On the Cover Sheet tab, fill out the following fields:

Job Location 90th Street & Shea

City Scottsdale

County Maricopa

Country United States

State Arizona

Type Infrastructure

Engineer Fred Jones

Owner Jerry Slate

Architect Robert Frost

Contract Duration 80

Time Measure Calendar Days

Forecast Start October 15, 2019

Duration (days) 70

Bid Date and Bid Time 10/1/2019 2:00 PM

Estimator Jim Sly

Bid Location 123 Main Street

Owner’s Estimate $500,000.00

Opening Type Public

Proposal Type Unit Price

Plan Holders 10

Liquidated Damages $1000.00 Per Day

RFQ Contact Jim Sly

2. On the Cost Basis tab:
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l Ensure the Shift Arrangement is 8 hours a day, 5 days a week

l Ensure the Wage Composite is set to 100% Scale 1

l Ensure the Sales Tax is set to 8%

You should end up with the following results

The following Cover Sheet properties are defined:

The following Cost Basis settings are defined:
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Congratulations, you have completed this exercise!
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4.3 PAY ITEM CREATION

Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Name Description

1
Proposal and Item
Recaps

Related to pricing during bid close-out. You can disregard them at this
time.

2 Pay Item Number Represents the bid item number from the client (if they give you one)
or can be a number you specify. This field is alpha-numeric

3 Row Number Controls the order of your pay items.

4 Description You can enter a pay item description.

5
Pay Quantity and
Forecast (T/O)
Quantity

The Pay Quantity is the quantity provided by the client.
The Forecast (T/O) Quantity is your measured quantity for the item.
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4.3.1 Overview – Pay Item & Proposal Register

Step by Step — Create a Pay Item

1. Open the E101 – Training Job and select Setup tab >Pay Item & Proposal from the InEight
Estimate landing page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type 1000.

l Notice the Row Number and Line Number columns automatically fill with a number for
you

3. Use the Tab key to move to the Description column and type Mobilization.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later
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l You can tab to the next row to create additional pay items if needed.
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Exercise 4.2 — Create Pay Items

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete
the following steps, using the E101 – Training Job.

Pay Item Number Description Pay Quantity Unit of Measure

2000 Clearing & Grubbing 10.00 Acre

3000 Excavation 50,000.00 CY

4000 10” PVC Pipe 1,000.00 LF

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 4 Review

1. This is where you enter basic information about the job as well as define your cost basis.

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview

b. Cover Sheet

c. Cost Basis

d. Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items

b. Resources

c. Target Price

d. Pay Items

Lesson 4 Summary

As a result of this lesson, you can:

l Create a new job

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register

Page 130 of 565 InEight Inc.  |  Release 20.1

Lesson 4 Review Estimate User Guide



InEight Inc.  |  Release 20.1 Page 131 of 565

LESSON 5 — ESTIMATE DIRECT COSTS

Lesson Duration: 90 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain the Cost Breakdown Structure and its purpose

l Create cost items

l Add costs and production

l Manage cost item details
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5.1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Name Description

1
Actions
Menu

Shortcut icons allow you to edit cost items and import items from other sources such
as Excel.

2 CBS Tree The CBS tree mirrors your CBS hierarchy and can be used to quickly filter to a
particular section of the CBS by selecting that line on the CBS Tree.

3
Left CBS
register

This side of the register contains all of the estimate activities (cost items) that you
create or import, organized into a parent-child hierarchy.

4 Right CBS
register

This side of the register contains numerous columns for cost detail, production
values, and user-defined tags and fields.

Overview – Cost Breakdown Structure (CBS) Register
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5.1.1 Cost Item Terminology

The CBS contains both direct and indirect costs.

l Direct Cost Items contain costs that pertain directly to the deliverables of the project. Direct cost
items will therefore be assigned to pay items.

l Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Terms Description

Superior
A Superior cost item has subordinate (child) items below it that determine hours and
costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal
A Terminal cost item has no subordinate items. Resources, costs, and production can
only be added at the terminal cost item level.

A Terminal cost item may or may not be a subordinate.
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The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As
costs are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost
items.

A superior cost item can have no costs of its own; its costs are strictly the rolled-up total
from the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5.1.2 Work Breakdown Structures

The Work Breakdown Structure (WBS) allows you to easily reorganize the estimate using different
formats such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats
are used when you need multiple variations and summary reports of an estimate. The WBS retains the
same relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Name Description

1
WBS
Tree

Use the WBS Tree to filter to a particular WBS item.

2 WBS
Grid

When a specific WBS item is selected in the WBS Tree,
all subordinate WBS items display in the WBS grid.

3
Cost
Items

The Cost Items associated with the WBS subordinate in
the WBS Grid displays in this data block.

Overview – Work Breakdown Structure (WBS) View
Register
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5.1.3 Locked vs. Unlocked Approach

There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost
items inherit the pay item assignment of superior cost items.
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If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.
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The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

5.1.4 Take-Off Quantities

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.
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Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

Step by Step — Adjust Take-Off Quantities

1. In the E101 - Training Job, from the InEight Estimate landing page, on the Estimate tab, select
Cost Breakdown Structure (CBS).

l In the Forecast (T/O) Quantity column, the Forecast (T/O) Quantity was brought over
from the Pay Item and Proposal Register, but here you can adjust it if needed

l For each cost item, you can enter the T/O quantity, followed by the unit of measure in the
next column

2. For this example, change Clearing & Grubbing to 15.00 Acre and Excavation to 40,000.00 CY.
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5.2 COST ITEM CREATION

During estimate development, you will create new cost items to break down your work into specific
activities. You can create superior and subordinate cost items as needed to organize your work.

5.2.1 Insert Subordinate Cost Item

You can add subordinate cost items in two different ways:

Option 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

Option 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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5.2.2 Insert Cost Item

You can add cost items at the same level in two different ways.

Option 1

Right click on the row header of the superior cost item and select Insert.
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Option 2

Click on the Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

Step by Step — Create a Subordinate Cost Item

1. In the E101 – Training Job, from the InEight Estimate landing page, on the Estimate tab, select
Cost Breakdown Structure (CBS).

2. Right click on the Clearing & Grubbing cost item and select Insert Subordinate.

l This creates a new cost item (2.1) below cost item 2

3. For cost item 2.1, type the Description Clearing.

4. Keep the quantity at 15 and keep Units of Measure as Acre.

You can create a subordinate at the same level, by right clicking on an equal-level
cost item and selecting Insert.

5.2.3 Move Cost Items

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:
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1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:

The symbol with three equal bars will drop the cost item at the same level as
the cost item you drop it on.

The symbol with a subordinate bar will make the cost item become a
subordinate to the one you drop it on.
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Exercise 5.1 — Create Cost Items

In this exercise, you will practice creating additional cost items. Create the following cost items,
using your E101 – Training Job:

Code Description Forecast (T/O) Quantity Unit of Measure

2.2 Grading 10 Acre

3.1 Excavate 40,000 CY

3.2 Haul 40,000 CY

4.1 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000 LF

You should end up with the following results

Congratulations, you have completed this exercise!
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5.3 COSTS AND PRODUCTION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5.3.1 Cost Item Record

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

Name Description

1
Cost Item
Header
Information

Provides general information about the cost item. It displays the cost item’s take-
off quantity, Unit of Measure, and Cost. It also indicates what Cost Source is
being used.

2 Costing Area Section where costs are defined. There are three ways to enter costs: Detail,
Plug, and Quote. The Cost Summary tab summarizes whatever costs are defined.

3 Data Blocks
Contains a set of tabs for entering additional information including production,
shift arrangements, man-hour factors, notes, and scheduling information.
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5.3.2 Cost Sources

You can define costs on a cost item in one of three ways, called Cost Sources:

Tab Description

Detail
This is the recommended costing method, where labor, equipment, and material resources
are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter
resources or production. This should rarely be used, but does have a couple of use cases:

l Place holder value until you get more information (from subcontractors or designers)
l For preliminary estimates when limited information is available

Quote
The Quote cost source is for contractors, subcontractors or vendor quotes.

l Creating and managing quotes is covered in Lesson - Quote Management
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On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.

5.3.2.1 Plug Tab

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be
customized based on company requirements.
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5.3.2.2 Detail Tab

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially
(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.
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The Quote Cost Source can only be selected from the Quote Comparison & Award form.
See Lesson 8 – Quote Comparison.

5.3.3 Plug Costs

The following steps walk you through defining a plug cost on a cost item.

Step by Step — Define a Plugged Cost

1. In the E101 – Training Job, from the InEight Estimate landing page, on the Estimate tab, select
Cost Breakdown Structure (CBS).

2. Right click on the row header for cost item 1Mobilization and select Open.

3. In the Cost Source drop-down field select Plug.
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4. In the left section of the Cost Item, select the Plug tab.

l This gives you the list of all cost categories, where you can enter either a Unit or Total Cost

5. Click in the LaborUnit Cost field and type 10,000. Click in the Owned Equipment Unit Cost field
and type 10,000.
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l The Total Cost for the cost item should now auto-calculate to be $20,000.00

5.3.4 Detail Costs

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

l A duration, or

l A unit per duration, or

l A duration per unit

Page 152 of 565 InEight Inc.  |  Release 20.1

5.3 Costs and Production Estimate User Guide



When you enter a production value, all the other production fields will auto-fill based on what you
entered.

The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

5.3.4.3 Add Cost Detail

The following steps walk you through adding resources and production on a cost item.

Step by Step — Add Cost Detail

1. In the E101 – Training Job, from the InEight Estimate landing page, on the Estimate tab, select
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Cost Breakdown Structure (CBS).

2. Right click on the row header for cost item 2.1 Clearing and select Open.

3. Select the Detail tab.

l Notice there is no cost on the Detail tab since no cost detail is defined

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. On the Labor tab, select the LL2 Laborer resource.

6. Select OK.
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l The labor resource you selected is now employed on the cost item

7. In the new blank row, click in the Code field and click on the Resource Selection icon to open
the Resource Selection Register.

8. Select the Labor tab, then select the LO1 Operator Class 1 resource.

9. Click OK.

10. In the new blank row, click in the Code field and click on the Construction Equipment tab, then
select the EL988 Loader 988 resource.

11. Click OK.

l Notice that the two labor resources and the construction equipment resource are now
employed on your cost item

l You will leave all of our quantities set to 1. You should end up with the following employed
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resources and quantities:

12. Because these are duration-based resources, you need to enter a Production value. From the
lower-right section of the form, select the Production tab.

13. Type 8 in the Days field, then press Tab.

l Notice the red arrow indicating where production was defined

l Notice that the Total Cost of the cost item is defined, based on the resources and
productivity you defined

14. Next, adjust the production by typing 1 in the Acre/Day field.
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l You can see that the red arrow indicates where the adjustment was made and it
automatically changed the days to 15

15. Click OK to close the record.

5.3.4.4 Add Assembly

Step by Step — Define Cost Detail by Adding an Assembly

1. Open the E101 - Training Job, from the InEight Estimate landing page, on the Estimate tab,
select Cost Breakdown Structure (CBS).

2. Right click on the row header for cost item 2.2 Grading and select Open.

3. Select the Detail tab.

l A blank row is available to define your costs

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.
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5. Select the CGRADE Grading Crew assembly, then select OK.

l The assembly you selected is now employed on the cost item

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type 1 in the Acre/Day field, then press Tab.
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l You should end with the following result:

l Notice the Total Cost of the cost item is defined, based on the resources included in the
assembly and the productivity you defined
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Exercise 5.2 — Define Cost Detail

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your E101 – Training Job:

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

EX225 Excavator 225 1

CY/Hour 400

Add the following resources to 3.1 Excavate cost item

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

LT1 Teamster 1

EL950 Loader 950 1

ETDT Dump Truck 1

EX225 Excavator 225 1

Add the following resources to 3.2 Haul cost item

CY/Hour 400

Add the following production value to cost item

Page 160 of 565 InEight Inc.  |  Release 20.1

Exercise 5.2 — Define Cost Detail Estimate User Guide



Code Description Quantity

MPP10 Pipe 10” PVC SDR21 1,000 with 5% Waste % Add-on = 1,050 LF

Add the following resources to 4.1 Furnish Pipe Materials cost item

Resource Assembly Description Quantity

CPIPE Pipe Crew 1

Add the following assembly to 4.2 Excavate-Install-Backfill Pipe cost item

Days 3

Add the following production value to cost item

You should end up with the following results

Congratulations, you have completed this exercise!
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5.4 COST ITEM DETAILS

The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

You can add to or adjust the information on these tabs as needed, based on the cost item’s
circumstances. In this section, you will review three of the tabs (in addition to the Production tab) you
will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

5.4.1 Cost Item Setup

On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage
scale and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

Step by Step — Adjust Shift Arrangements

1. Open the E101 - Training Job, from the InEight Estimate landing page, on the Estimate tab,
select Cost Breakdown Structure (CBS).

2. Right click on the row header for cost item 2.1 Clearing and select Open.
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3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your wage scale to 80 for Scale 1 and 20 for Scale 2.

l Notice that your Laborer and Operator Class 1 Unit Costs go up because you are now using
a blended (80% scale 1, 20% scale 2) rate

5. Under the Composite Wage Scale, adjust the hours so that for every 10 hours worked, pay 10
hours.

6. In the Default Shift Arrangements data block, change the Work Hours per Shift to 10. Leave
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Shifts per Day at 1 and Days per Week at 5.

l Notice that your hours did not change on the cost item (they will remain constant)

l However, if you go back to the Production tab, you will also see that it automatically
adjusted your other production values based on the new settings (e.g., Days changed from
15 to 12, Acre/Day is now 1.25 instead of 1)

5.4.2 Notes

On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:

l For a Hauling cost item:  There should be very little waste. If so, we can spread it out in the right
of way at MP 111

l For a Structural Excavation and Backfill item:  The backfill cannot be the native material. Have
to use clean base rock

l For an Underground Pipe cost item:  The average depth is close to 10 ft.
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You can use the Notes tab to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).

5.4.3 Man-Hour Factors

For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to
take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Even after defining a Man-Hour Factor, the Production tab will still display the original Production
values.

l To see the factored Production values, click the Customize Display link on the Production tab
and select Show Man-Hour Factors

l Both original and factored production are then displayed on the Production tab
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You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected
cost items on the CBS Register.

5.4.4 Unique Identifier

You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.
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On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project
library of resources rates.

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.
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This same identifier will show up for resources as well, if you make changes to the employed
resource’s cost to be different than the original resource rate imported from the Resource Rate
Register.

5.4.4.1 Highlight Unique (Delta) Toggle

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.
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5.4.5 Cost Drivers

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
the cost driver is CI Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.
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With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.

If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to CI Duration and the Work Hours back to 100.
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5.4.5.2 Split by Cost Type

It is common for an estimate to progress through multiple levels of detail. Often a high-level estimate
for a particular scope of work consists of a single cost item inclusive of the entire cost of that work in a
single line item. As the estimate is further refined, more detail is added and at times it can become
necessary to split a cost item by the four main types of costs that make it up, such as separating the
material cost from the installation cost.

The Split by Cost Type feature gives you the ability to select a cost item or a collection of cost items,
and then separate any of the labor, equipment, material, or subcontract costs into separate cost items.

l Right click on a new Cost Item under Guardrail Type 2, and select Split by Cost Item. You can
use this option if there at least two types. If not, you will get this pop-up:

Alternatively, click on Split.
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l Enter the number of parts to split and click OK

l You will be asked if you want to proceed.  If so, click Yes

The end-result will automatically add subordinate rows which you can now edit.

5.4.6 Suspend Cost Items

The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:
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l Manually suspended cost items

l Suspended parent

l Parent with cost source that is not Detail (plugged or quoted)

l Parent cost item with a zero quantity

l Pay item is suspended

l Allocated cost items

l Alternate scenarios

l Overridden by another alternate

l Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-
suspended at anytime in order to be included in the total project value.

Step by Step — Suspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select the 10” PVC Pipe cost item.

2. Right click on the selection and select Toggle Suspended from the menu.

l You can also select Toggle Suspended under the Edit section of the Actions tab up above

l You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record

l The 10” PVC Pipe cost item is now suspended, and since it was a superior cost item, the
subordinates are automatically suspended along with it
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l The costs associated with these cost items will no longer contribute to the estimate

Step by Step — Unsuspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select the 10” PVC Pipe cost item.

2. Right click on the selection and choose Toggle Suspended.

l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

5.4.6.3 Suspend Column

Within the CBS Register, the Suspend column indicates which cost items are suspended.
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l Hover over the checkmarks to see why the cost item is suspended

l You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the
Suspend column as well

5.4.7 Adding Cost Adjustments

Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either
from the Standard view of the CBS register, or a saved view affiliated with change.

Adjustment fields have been added to the CBS to view and modify the adjustment amount and
adjustment percent without going into each individual cost item.

Any adjustment made to the Adjustment Amount fields on the CBS register will then have the
Adjustment Percent field automatically calculated. Changes made to those fields will be highlighted in
yellow signifying an adjustment has been made.
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Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown
Structure.
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Exercise 5.3 — Manage Cost Item Details

In this exercise, you will practice making adjustments to your cost item details. Complete the
following steps, using your E101 – Training Job:

1. Open the Cost Item Record for cost item 2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1, 20%
Scale 2.

3. Change the Default Shift Arrangements to 10Work Hours per Shift, 1 Shift per Day, 5
Days per Week. Also adjust for every 10 hours worked, pay 10 hours.

4. From the Man-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.

5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with the following results for 2.2 Grading

Congratulations, you have completed this exercise!
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Lesson 5 Review

1. Resources, costs, and production can only be added to what type of cost item?

a. Superior

b. Terminal

c. Parent

2. What Cost Source is used for defining resources and production?

a. Plug

b. Detail

c. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup

b. Production

c. Man-Hour Factors

d. Notes

Lesson 5 Summary

As a result of this lesson, you can:

l Explain the Cost Breakdown Structure and its purpose

l Create cost items

l Add costs and production

l Manage cost item details
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LESSON 6 — ESTIMATE INDIRECT COSTS

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items
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6.1 INDIRECT COSTS OVERVIEW

Once your direct costs are defined, you can add indirect project costs. InEight Estimate provides two
ways you can create indirect costs:

1. Default Indirect Cost Items:  These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

2. User-Defined Indirect Cost Items:  Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.

The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab,
Master Breakdown Structures section, controls which of the default indirect cost
items to copy into new job folders.

Page 182 of 565 InEight Inc.  |  Release 20.1

6.1 Indirect Costs Overview Estimate User Guide



6.1.1 Navigation to Indirect Costs

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

l Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

l You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6.2 DEFAULT INDIRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6.2.1 Independent Indirect Cost Items

Independent indirect cost items function very much like the direct cost items you defined previously:

l Job Management & Equipment

l General Expense

6.2.1.1 Job Management & Equipment

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.
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The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

Step by Step — Add Job Management & Equipment Costs

1. In the E101 - Training Job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Double click on the Job Management & Equipment row header.

l You can see that this record looks like the direct cost item records that you have been
working with thus far in the CBS

4. Here you will add Labor resources by clicking in the Code column and selecting the icon. Add
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LSSEC Secretary and LSSUPT Project Superintendent.

5. Select the Production tab.

6. Type 70 in the Days field.

l This represents the length of the job

7. Click OK to close the record.

Step by Step — Add General Expense Costs

1. In the E101 - Training Job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Right click on the General Expense row header and select Open.

l The General Expense cost item record also looks identical to a direct cost item record

l You could add existing resources here, but in this case, you will create an ad hoc resource

l Assume you don’t have a resource for General Office Supplies

4. Type General Office Supplies in the Description column.
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5. Type 1 in the Quantity field.

6. For the Unit of Measure, select Lump Sum from the drop down.

l Notice that the Unit Cost column is read only

7. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

8. Type 1,000 in the Undefined Supplies cost category.

l The amount entered automatically fills into the unit and total cost columns

You are only allowed to enter information in the Resource Cost Breakdown if
the resource row is selected, otherwise fields will not display.

9. Click OK to close the record.

6.2.2 Dependent Indirect Cost Items

The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

l Direct and Indirect Cost Add-On

l Direct and Indirect Cost Escalation
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l Prime Bond

l Price % Add-On

l Job Financing

l Man-Hour Add-On

6.2.2.2 Default Dependent Cost Item Deletion

If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.

Step by Step — Delete Existing Default Dependent Cost Items

1. In the E101 - Training Job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Select the Prime Bond indirect cost item by clicking on its row header.

4. Press and hold the Shift key while selecting the Job Financing indirect cost item.

l All your dependent indirect cost items are now selected
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5. Right click on the selection and select Delete.

6. Select Yes to confirm you want to delete the selected Cost Items.

l Your indirect cost items are now deleted

6.2.2.3 Prime Bond

The following steps walk you through adding and defining your prime bond for the job.

Step by Step — Define Prime Bond

1. In the E101 - Training Job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Right click on the row header for any cost item and select Insert Dependent Cost Item.

4. On the resulting Attention prompt, select Based on Bond Table.
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5. Click OK.

l The Prime Bond indirect cost item now displays at the top of your CBS

6. Right click on the Prime Bond row header and select Open.

l Prime Bond represents the insurance for the job

l This is an irregular form and uses bond rate tables

l The form’s Bond Table Name defaults to No Bond Required until a saved Bond Table
Name is chosen

7. Use the Table Name drop-down to choose EXAMPLE: GENERAL CONSTRUCTION
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8. Click OK to close the record.

l The Prime Bond indirect cost item is now added to your CBS

6.2.2.4 Price % Add-On

The following steps walk you through defining the Price % Add-On.

Step by Step — Define a Price % Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.
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3. Click OK.

4. Double click on the Price % Add On row header to open the record.

5. The Price % Add-on Record opens to the Description tab. Type Office Overhead in the
Description field and type a rate of 4.
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l Office Overhead is now defined with a rate of 4% of the job’s price

6. Click OK to close the record.

6.2.2.5 Direct Cost Add-On

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a Direct Cost Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.

3. Click OK.

4. Double click on the Direct Cost Add-On row header.

5. On the Description tab, type Small Tools in the blank row under the Description column.
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6. Press the Tab key (you can define additional rows for other add-on costs as needed).

l The Dependency Cost Breakdown appears on the right

l The Subject Cost is the cost that the cost item depends on, based on what is defined on the
cost item’s Dependency tab

7. Click on the Dependency tab to see what contributes to your subject cost.
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l These are the cost items on which this Direct Cost Add-On depends

l There are a couple of options at the bottom to control how dependency items are selected.
By default, the bottom radio button is selected

l The bottom radio button allows you to use column filtering to control what items are
included

l The top button allows you to manually select the cost items you would like to include

8. For this activity, leave the default (lower) button selected.

9. Click on the Description tab, where you can define an add-on Rate (percentage) or Cost at any
of the cost category levels in the Dependency Cost Breakdown on the right side of the record.

l You can also add a rate at the Total level to have it apply to all your cost categories

10. Type 10 in the Rate field at the Labor cost category level, then press Tab.
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11. Click OK to close the record.

6.2.2.6 Repositioning Dependent Cost Items

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are
now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

• Subject Cost

• Subject Cost Rate

• Subject Billing Amount

• Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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6.3 USER-DEFINED INDIRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the
same way you create direct cost items. The only difference is that your indirect cost items will not be
assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a
parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:
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Step by Step — Add User-Defined Indirect Cost Items

1. At the bottom of your CBS, create an Indirect cost item called Job Overhead with a Forecast
(T/O) Quantity of 1 and a Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is also
1 Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double clicking on the row header.

l Assuming there is no Job Trailer in your Resource Rate Register, you will create this
resource “on the fly”

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

InEight Inc.  |  Release 20.1 Page 197 of 565

Estimate User Guide 6.3 User-Defined Indirect Cost Items



5. On the Resource Rate Register, click the Rented Construction Equipment tab.

6. Right click on one of the line items and select New to add a new resource.

7. Enter a Resource Code of RJT for the Rented Construction Equipment Resource.

8. In the Description field, type Job Trailer.
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l You do not need to enter Fuel, but the Job Trailer’s cost is given to you at a charge per
week, so you will use the Non-Hourly Period Charge Rates to figure out the hourly cost

9. Select the Calculate Non-Hourly Period Charge Rates for RE Rental checkbox; this will allow
you to edit the fields below the checkbox. A pop-up box will appear.

10. Click OK on the resulting prompt.
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You may need to expand the resource record to see all of the fields to fill out.

11. SelectWeekly as the Period, and type 1,000 as the Amount Per Period.

12. Since the Period is Weekly, type 40 in the Hours Per Period field.

13. Press the Tab key so the change takes effect on your Cost Category Breakdown (on the left).

l Now you can see that $25.00 auto-filled into the Rented Equipment category, as well as
your Standard Sales Tax of $2.00 under Fees in the Cost Category Breakdown, to equal a
total of $27.00 per hour

14. Click OK to close the Resource Rate Record.
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15. Select the new RJT resource you created, then click OK to return to the Cost Item Record.

16. On the Cost Item Record, adjust the Job Trailer Quantity to 2, assuming you will have 2 Job
Trailers on site.

17. Finally, adjust your production by entering the duration of the job.

l You estimate the project duration to be 70 Days

18. Click OK to close the record.

19. On the CBS register, select the Utilities cost item by double clicking on the row header.

20. Create another ad hoc resource on this cost item called Electricity, which will be 1Lump Sum.

21. Finally, go to the Resource Employment Breakdown tab and enter your forecasted electricity cost
for the duration of the job. Type 1,500 on the Custom Category1 row.

22. Click OK to close the record.
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l Your user-defined indirect cost items now contain production and costs
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Exercise 6.1 — Define Indirect Costs

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using the
E101 – Training Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.

4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety
& Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs
only.

7. Click OK to close the record.

You should end up with the following results

InEight Inc.  |  Release 20.1 Page 203 of 565

Estimate User Guide Exercise 6.1 — Define Indirect Costs



Congratulations, you have completed this exercise!
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Lesson 6 Review

1. The ___________ in the Library controls which of the default indirect cost items to copy
into new job folders?

a. Job Properties

b. Foundation Setup Data

c. Cost Breakdown Structure

2. If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

a. True

b. False

3. You create user-defined indirect cost items the same way you create direct cost items.
The only difference is that your indirect cost items will not be assigned to ___________.

a. Resources

b. Pay Items

c. Assemblies

Lesson 6 Summary

As a result of this lesson, you can:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items

InEight Inc.  |  Release 20.1 Page 205 of 565

Estimate User Guide Lesson 6 Review



Page 206 of 565 InEight Inc.  |  Release 20.1

This page intentionally left blank.

Lesson 6 Summary Estimate User Guide



InEight Inc.  |  Release 20.1 Page 207 of 565

LESSON 7 — FINALIZE THE ESTIMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments

Lesson Topics
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7.3.4 Define Pricing for Pay Items Manually 223
7.3.5 Use AutoPrice to Balance and Hit the Target Total 224
7.3.6 Use AutoPrice to Unbalance and Hit the Target Total 225

Exercise 7.1 —Manually Price Pay Items 228
7.4 Bid Adjustments 229

7.4.1 Lock Price 229
7.4.2 Suspend Pay Items 232

Lesson 7 Review 235
Lesson 7 Summary 235
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7.1 JOB MARKUP (PROFIT)

On the Data Map  notice how the different segments within the pyramid coincide with the
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. Illustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

7.1.1 Target Price

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.
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On top of your direct costs, you add your indirect costs which consist of Business and Job Overhead.
You estimated your direct and indirect costs already in the CBS Register.

At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of
Indirect Cost Markup.
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The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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7.1.2 Price Breakdown Structure

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.
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The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.

Name Definition

1
PBS
Description

The left side of the screen displays several cost classifications:
l Target Profit
l Business Overhead
l Job Overhead
l Direct Cost

2 Cost and
% of
Target

Each layer displays with an amount, and the percentage of the Target Price that
this amount represents.

3 PBS Menu
The right side of the screen holds several tabbed pages of information. This
information is useful in analyzing the job at a summary level.

4 Refresh
Data

To ensure that you are always reviewing the most up-to-date factors and ratios,
click the Refresh Summary Data button whenever you are reviewing the data.

Overview – Price Breakdown Structure
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All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-
off quantities).

7.1.3 Markup vs. Margin

Let’s look at the difference between Markup and Margin.

l Markup is a function of cost, while margin is a function of price

l Markup indicates how much you are marking up the cost

l Margin indicates what percentage of your price the markup represents
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The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.

When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

7.1.4 Define Profit

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.
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You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.

7.1.4.1 Profit as a Percentage of Target Price

Step by Step — Add Profit as a Percentage of Target Price

1. Open the E101 – Training Job in InEight Estimate.

2. From the InEight Estimate landing page, select the Price tab.

3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.
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4. On the Target Profit row, type 10 in the % of Target Price column, then press Tab.

Notice that entering the 10% Target Profit has the following effects, once you tab off the field:

l Your Target Price increases

l Indirect and Direct Cost Markup values automatically have amounts pushed down to them

l The amounts for both Prime Bond and Price % Add-On increase, as they are based on a
percentage of the Target Price

l Direct Cost and Job Overhead amounts don’t change, but their % of Target Price changes

7.1.4.2 Profit Through Direct Cost Markup Record

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

Step by Step — Modify the Direct Cost Markup Record

1. On the Price Breakdown Structure (PBS) form, double click on the Direct Cost Markup row.

2. In the Markup Cost Item Record, override the Default entry with Direct Cost Markup in the
Description field.
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3. In the Rate column on the Dependency Cost Breakdown, type 15 in the Labor Cost Category, 10
for Owned Equipment, 8 for Materials and 2 for Fees. Reset the other categories back to 0.

l Notice the average rate rolls up at the Total cost category level

4. Click OK to save your changes and return to the PBS.

l The Direct Cost Markup now is a different percentage of the Target Price, and the Target
Profit and Target Price have changed

5. Click the Refresh Summary Data button on the PBS to see the changes reflected.
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7.2 COST ESTIMATE AUDIT/REVIEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.

7.2.1 Price Breakdown Structure Tabs

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

7.2.1.1 Markup Analysis

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

7.2.1.2 Cost Source

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.
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7.2.1.3 Resource Utilization

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on the
job, based on take-off quantities.

7.2.1.4 Subcontract Status

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
quoted cost items. This is a good place to review how much of your estimate is subcontracted.
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7.2.1.5 Vendor Status

The Vendor Status tab displays a breakdown of vendor information, including amounts and percentages
of the Target Price represented by vendors. This is a good place to review how much of your estimate
costs come from vendor quotes.

7.3 SPREAD TARGET PRICE OVER PAY ITEMS

In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

7.3.1 Current Price vs. Target Price

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Item & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.
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7.3.2 Proposal Recap

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

7.3.3 Spread the Target Price

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.
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7.3.4 Define Pricing for Pay Items Manually

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.

Step by Step — Define Pricing Manually

1. From the InEight Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

l Review the Proposal Recap and determine where adds or cuts are needed. Since your
Current Price is $0.00, you need to add the entire Target Price to your pay items

3. Select the row for pay item Mobilization.

l Notice at the top-right of your register you have an Item Recap to tell you what the direct
cost, overhead and profit would be for the Civil Work pay item if it was balanced
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4. First, define pricing manually. In the Total Price (current) field for the Mobilization item, type
20,000.

5. On the pay item Clearing & Grubbing, use Go to Column (<Ctrl> - G) to find the % Margin
column, bring it in next to the Total Price (current) column, and type 5.

7.3.5 Use AutoPrice to Balance and Hit the Target Total

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice
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feature.

Once distributed, you will still have the ability to adjust your pricing on pay items
manually as needed.

Look at how you can use the AutoPrice feature.

7.3 Step by Step 1 — Use AutoPrice to Balance and Hit the Target Total

1. Open the E101 – Training Job in InEight Estimate.

2. From the InEight Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.

4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

7.3.6 Use AutoPrice to Unbalance and Hit the Target Total

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.

7.3 Step by Step 2 — Unbalance Hit Target Total

1. Within the Pay Item & Proposal Register of your E101 – Training Job, note your overrun and
underrun items.
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2. Highlight the row for each item to view it’s current balanced item recap.

3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

l You will see the changes reflected for Clearing & Grubbing and Excavation and how the
profit was spread to your overrun and underrun items
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4. Lastly, if you highlight each item you will note that all your overhead and profit from Excavation
was put onto Clearing & Grubbing.
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Exercise 7.1 — Manually Price Pay Items

To finalize your bid proposal, you will apply final pricing (costs and profit) to your pay items either
manually or using the AutoPrice tool. In this exercise, you will practice entering prices manually for
your pay items. Complete the following steps, using your E101 – Training Job.

1. Continue manually pricing items in the Pay Item & Proposal Register.

2. Type 2.75 in the Unit Price (current) column for pay item Unclassified Excavation.

3. Type 2 in the % Margin field for pay item 4000 – 10” PVC Pipe.

4. Check your variance to see if you need to add or cut your current pricing to hit your
Target Price.

You should end up with the following results

According to the Proposal Recap, you need to add $21,611.42 to reach your Target Price.

Congratulations, you have completed this exercise!
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7.4 BID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

7.4.1 Lock Price

You can lock down a pay item price and it will not factor in future rebalancing.

7.4 Step by Step 1 — Lock Price

1. Select the Lock Price checkbox on the Mobilization row.

l Mobilization’s price is now locked

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

7.4 Step by Step 2 — Make Last Minute Bid Adjustments

1. With the E101 – Training Job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.
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3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.

4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type Cut for the new description.

6. Make the cut in Material cost by typing -1000 in the Cost column of the Materials Cost category
under the Cost Breakdown section on the right.

7. Press the Tab key, and your cut will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.

l You see a notification letting you know that changes have been made and the Pay Item &
Proposal must be refreshed to reflect the changes
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9. Click the Refresh button.

10. On the Actionsmenu, select Balanced Bid > Hit Target Total.

11. An Auto Price Warning displays, informing you of rounding variances. After reading the details,
click the Close button.
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l Note on the proposal recap that a variance still exists because there are limited number of
pay items to spread the rounding error over

l Note that Mobilization did not adjust, since Mobilization’s price was locked, but the other
pay items were updated

l Note that you can overwrite locked items for spreading your price by checking the
Overwrite Locked Pay Items option on the Actions menu

7.4.2 Suspend Pay Items

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the
estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to
no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute to
the overall total price.

You can suspend/unsuspend pay items in one of three ways:
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l Right click on the pay item and select Toggle Suspended

l Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab
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l Open the pay item record and checking/unchecking the Suspend box
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Lesson 7 Review

1. What are all costs in the Price Breakdown Structure based on?

a. Pay Quantities

b. Forecast (T/O) quantities

c. Direct Costs

d. Indirect Costs

2. When adding profit, it must be the same amount for direct and indirect costs.

a. True

b. False

3. What options do you have to enter profit on the PBS?

a. % Mark-Up, % Margin, and Fixed Dollar Amount

b. % Mark-Up or % Margin

c. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.

a. True

b. False

Lesson 7 Summary

As a result of this lesson, you can:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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LESSON 8 — QUOTE MANAGEMENT

Lesson Duration: 60 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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8.1 QUOTE MANAGEMENT OVERVIEW

8.1.1 Quote Management Workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

8.1.2 Quotes and Quote Groups

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost item
level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:
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8.1.2.2 CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.

8.2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 Request for Quote (RFQ) Register Overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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8.2.2 Request for Quote (RFQ) Record

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Name Definition

1
RFQ
Description

Each record contains a Description, Deadline Date and Deadline Time fields to
identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the quote,
terms & conditions, and the seller companies to receive the RFQ.

3
Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent out),
and when it was published.

Overview – Request for Quote (RFQ) Record
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8.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group
so you can add multiple materials or subcontract items at once

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3.1 Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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8.2.3.2 Terms & Conditions

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

8.2.3.3 Seller Companies

You will use the Seller Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the InEight Estimate Library Address Book. This tab will
store all of the pertinent contact information for each seller, including their fax number and/or email
address so that you can send them the RFQ.
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The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

l Publish by Fax:  If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

l Publish by Email:  If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not
give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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8.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

8.2.6 Publish an RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or automatically sent via email to the supplier or subcontractor.
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When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ,
To do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the
RFQ Record ribbon.

8.2 Step by Step 1 — Create and Publish an RFQ

1. Open the Training Job.

2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. From the Actions tab, click on the New icon to create a new RFQ.

5. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

6. Select the Aggregates Quote Group Description.
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7. Click OK.

l The Request for Quote (RFQ) Record is created with two aggregate line items

l The Description field is automatically filled with the name of the quote group
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8. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type 2:00 PM.

9. Select the Terms & Conditions tab.

10. Type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

11. Type All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.
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12. Select the Seller Companies tab and click in the first blank row in the Company Name column.

13. Click on the Address book icon, and select the following example vendors, then click OK:

l Example Vendor 1:  Pat Roberts

l Example Vendor 2:  Stan Mark

l Example Vendor 4:  Lester Slim

14. Make sure Publish by Fax is checked for all sellers, and that they all have Fax numbers.

l Also make sure Publish by Email in unchecked for each vendor

15. Select the sellers to whom you want to send the RFQ.

16. Under the Actions tab of the record, select Publish to create your RFQ document.
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l MSWord opens the file automatically for you to review; and from here you can either
print it or send it in an email as an attachment

17. Click OK to save the RFQ Record.

Page 252 of 565 InEight Inc.  |  Release 20.1

8.2 Requests for Quote Estimate User Guide



8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.

8.3.1 Sample Received Quote Scope Sheet

Name Description

1 Section one

Scope item one includes 4 items the subcontractor has considered as work to be
done onsite. You may want to consider adding all 4 items as individual quotes.
Then creating a package identifying these quotes as on-site work, totaling
$203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as work to be
done offsite. You may want to consider adding all 3 items as individual quotes.
Then creating a package identifying these quotes as offsite work, totaling
$24,650.

3 Exclusions
The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If selected
all 3 are considered accepted terms. .

Overview – Received Quote Scope Sheet
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8.3.2 Quote Register Overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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8.3.3 Quote Record Overview

The Quote Record establishes who the vendor is, along with quoted prices and all terms and conditions.
Once a requested quote returns, you can either create the quote in InEight Estimate from scratch or
convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each Quote Record
contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Name Description

1
Header
block

You can include detailed contact information about the supplier or subcontractor. This
automatically fills when you select the seller from the Address Book. The External Ref
field can be used to access information specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the quote,
including taxes, item conditions, and special conditions.

3
Quote
tabs

The tabs at the bottom of the screen hold detailed information regarding the quote.

4 Default Data blocks include Special Terms & Conditions, Qualifications, Packages, Taxes,

Overview – Quote Record
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Name Description

Data
Blocks

Seller’s Profile, Setup, and Minority.

Overview – Quote Record (continued)

8.3.4 Header Block

The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – a code used to reference the received quote.

l Date – date the quote is received.

l Source – this is the method by which the quote was received. The options are email, fax, hard
copy, phone, and other.

l Currency – system of money in general use for a particular country..

l Ignore – by ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.
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8.3.5 Price Block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.

8.3.6 Quote Record Tabs

8.3.6.1 Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.

l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

l Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item
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8.3.7 Data Blocks

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
to the default setting, which shows all six data blocks.

Data Block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages

l Taxes

l Seller’s Profile

l Setup

l Minority

The six data blocks appear at the bottom right of the screen.
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It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

Drop the data block on top of an arrow where you wish to land the data block.
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The data block will now reside on the left side of the screen.

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.
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8.3.8 Data Block Tabs

8.3.8.2 Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.

8.3.8.3 Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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8.3.8.4 Packages

Using the Packages feature allows you a way to arrange quotes into a collection which makes sense for
packaging your quotes. You can determine how to intake quotes from subcontractors and classify them
into a package grouping.

By creating a Package code within the Packages block, and giving it a dollar value, you can then assign
that package code to one or many quote records. In this case, the subcontractor provided quotes for
both on site and off-site concrete work. You can then determine which individual quotes go with the on
site or off-site package. The Package Amount field carries over to the Extended Price field under the
Cost Items tab.
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You can also create a package by selecting multiple items and selecting Add to new Package.

8.3.8.5 Taxes

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.

8.3.8.6 Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.
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8.3.8.7 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.

Page 264 of 565 InEight Inc.  |  Release 20.1

8.3 Quotes Estimate User Guide



8.3.8.8 Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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If any of your Data Blocks become deleted on a Quote Record, simply click the Default
Data Block icon.

8.3.9 Create a Quote from RFQ

Walk through the steps of creating a quote from an RFQ.

To create a quote from scratch, click the New icon on the Quote Register and fill in the
quote details and seller fields manually.

8.3 Step by Step 1 — Create a Quote from RFQ

1. Open the Training job.
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2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. Open the RFQ record for which you’ve received quotes. In this case, select the Aggregates RFQ.

5. Select the Seller Companies tab and select the sellers for whom you need to create quotes. In
this case, select all of the sellers.

6. From the Actions menu, select Create Quote.

l InEight Estimate will create quotes for each of the sellers you selected
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l A prompt indicates how many quotes were created (3), then click OK

7. Close the RFQ Record and the RFQ Register.

8. To open the Quote Register, select Quote from the InEight Estimate landing page.

9. Select Quotes from the Quote Management section.

l The quotes that you created from RFQ are now listed on the Quote Register

8.3.10 Enter Quote Details

Now that you have quotes created, you can enter pricing.

8.3 Step by Step 2 — Enter Quote Details

1. Open the Aggregates Quote Record for seller Vendor 1 – Pat Roberts.
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2. On the Resources tab, make sure No Split is unchecked for all items.

3. Also on the Item Resources & Cost Items tab, now enter the following Unit prices for the
resources:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

4. Click OK to close the Quote Record.

8.3 Step by Step 3 — Create a Multi-packages Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click into one of the Pipe Materials.

4. In the Description field, type over the current description and type: Pipe Materials for site
improvements.

5. In the Contact field, select Example Vendor 1 - Pat Roberts.
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6. Click OK

7. Select the Cost Items tab on the left side of the screen.

8. Add cost item 7 under Cost Items.

9. Add cost item 8 under Cost Items.

10. On the Packages tab, enter the following 2 new records:

1. Code: P1

2. Description: On Site

3. Amount: $200,000

4. Code: P2

5. Description: Off Site
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6. Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated package
quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.

8.3.11 Duplicating an Existing Quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

8.3 Step by Step 4 — Duplicate an existing Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.
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4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

l The resources and prices from the quote you previously selected have been copied into a
new Quote Record.
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6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate quote.
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8. Once done, click OK.
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Exercise 8.1 — Quote Management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
InEight Estimate quote records. In this exercise, you will practice entering quote details. Enter the
following Quote Record details, using the Training Job:

Quote
Name:
Aggregates

Seller Name: Example Vendor 2 - Stan Mark

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)

Special Instructions Seller is NOT willing to split items.

Quote
Name:
Aggregates

Seller Name: Example Vendor 4 - Lester Slim

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

Resource Code Description Unit Price

Quote Name: Aggregates Seller Name: Example Vendor 4 - Lester Slim

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with the following results
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Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to determine
which is the preferred vendor or contractor to carry their pricing in your estimate. The Quote
Comparison & Award forms improve visibility into comparative analytics, while increasing efficiencies
in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 Quote Comparison & Award Overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Name Definition

1
Resource and
Cost Item Filter

You can show either your quoted resources or cost items.

2 Quote Group
Filter

This section provides checkboxes to further filter your items. The Quote
Group Filter allows you to mark the quotes as reviewed.

3
Quote
Description and
Vendor

Your quotes display with the vendor name plus the quote description.

l Awarded items have an award symbol
If an item is designated as No Split, it has a chain link icon

l Awarded and Locked items have a lock symbol next to the award

symbol

4 Cost Source Type The cost source can either be a Plug or Detail type.

Overview – Quote Comparison and Award Form
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8.4.2 Edit Mode

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.
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8.4.3 Substitute Values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.

When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:

1. Awarded splittable quote

2. Lowest splittable quote you’ve received
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3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute value
it displays the vendor whose substitute value has been used.
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When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.

8.4.4 Display Ignored Quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.
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From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote cannot
be awarded. The ignored quotes get appended to the right end of the QC&A form.

8.4.5 Additional Quote Comparison and Award functions

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Name Definition

1
Asterisk next to
Quote Item

An Asterisk (*) is displayed on a quote to indicate when that quote includes
quote items appearing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3
Updated Quote
Items Tool tip

Quote Item Tool tip displays details including:
l Unit Price
l Extended Price

Overview – Additional Quote Comparison and Award Functions
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Name Definition

l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

Overview – Additional Quote Comparison and Award Functions (continued)

8.4.6 Configure Totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after the
quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.
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8.4.7 Adding Notes to Quote Comparison & Award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
quote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.

8.4 Step by Step 1 — Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the next
steps.
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3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.

5. Select the check box in the Visible column for the Notes caption.

6. Select OK.
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l The Notes section displays on the Quote Comparison & Award form.

8.4.8 All Quote Groups Layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote group
impacts the entire estimate. In addition, the quote groups layout provides you with the visibility and
flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Name Definition

1
Totals per Quote
Group

Ability to see the Awarded Total Plug, Detail and Quote amount per
Quote Group

2 Total Awarded Visibility into the Total Awarded Amount per Quote Group

Overview – Quote Groups Layout
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Name Definition

Amount

3 Comparable totals Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the quote
items

Overview – Quote Groups Layout (continued)

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.9 Compare and Award Quotes

To award an item, right click on that item and select Award.
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The Award icon displays next to the awarded item(s).

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.9.1 Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.
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8.4.9.2 Award Status

The Award Status indicates whether or not all quotes are awarded within a quote group.

8.4.9.3 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.
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Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

8.4 Step by Step 2 — Compare and Award Quotes

1. Open the Training job, and from the main InEight Estimate landing page select Quote > Quote
Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.

3. Under Description, select Asphalt Materials.

4. Review the quotes to determine the lowest bidder:

l Select the Configure Total icon in the tool ribbon to view additional captions

l Both vendors have no split items for both resources.
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5. Example Vendor 1 has the lowest comparable amount, so award all to Vendor 1 by right clicking
on the Example Vendor 1 Asphalt Materials and selecting Award All.

l By awarding Example Vendor 1 both resources, the award ribbon icon displays next to the
unit price.
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l You could also change your mind and award Example Vendor 2 one of the resources. In
this case, award resource code MAFA to Example Vendor 2.

6. Right click on $7.35 under Example Vendor 2, and select Award.

l You now have awarded resource code MAFA to Example Vendor 2.

8.4.10 Package Entire Quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial
if you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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8.4.11 Incomplete Quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not provide
their prices until right before the bid is due. These quotes display in gray in the Quote Compare and
Award form.

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.
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8.5 SCOPE ITEMS

During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items, you
can create and evaluate checklists and quote group exclusions, and account for them within the Quote
Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting the checkbox, you can
indicate scope items and uncheck items that are not included. The amount associated
with these items will then total up in the Special Conditions subtotal. The person
responsible for awarding quotes needs to update the Inclusions field to correspond with
what the subcontractor has agreed to include in the quote.

Overview – Quote Record – Scope Items
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Section Description

1
Scope
Items

Quote Comparison and Award checklist items for your quote that help with
evaluating subcontractor and supplier quotes in greater detail. This is used to
ensure certain items are either included (inclusion) or excluded (exclusion) in the

Overview – Quote Comparison and Award – Scope Items
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Section Description

quote and accounted for by the entity awarding the quote.

2 Scope
Item
Inclusions

Maintained in Quote Record form. These are the Seller’s Special Terms &
Conditions scope items that the subcontractor is including in their quote price.
When the scope item contains a value, the subcontractor is agreeing to perform
the work. 

3
Scope
Item
Exclusions

Maintained in Quote record form. These are the Seller’s Special Terms &
Conditions scope items price. If the Inclusions checkbox is blank, the subcontractor
is NOT agreeing to perform the scope items.

4 Scope
Item
value

An entered value means that the subcontractor is excluding this scope of work.
However, you may add an amount because this scope could incur a cost. Once the
bid is awarded, you may find another subcontractor to perform the work. You are
simply accounting for a cost for this scope of work. In the example below, HD
Engineering is not going to paint the electrical equipment, but you know the cost is
$150.00. You are showing this cost to account the cost for this scope of work that
needs to happen.

5

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting this checkbox, you
can indicate scope items and uncheck items that are not included. The amount
associated with these items will then total up in the Special Conditions subtotal. The
person responsible for awarding quotes needs to update the Inclusions field to
correspond with what the subcontractor has agreed to include in the quote.

Overview – Quote Comparison and Award – Scope Items (continued)
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The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best value.
In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the best
quote to go with.

The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
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included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 Scope Item Setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each Quote
Group Tag Record, you can list out scope items that break down the work into smaller scopes of work,
along with the estimated cost amount associated with each scope item.
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8.5.2 Scope Item Creation and Award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

8.5 Step by Step 1 — Create and Award Scope Items

1. Open the Training Job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote Group Tags tab to setup Scope Items within a Quote Group.

5. Create a new Quote Group Tag called Electrical Work and click OK.
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6. Open Electrical Work and add the following Scope Items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work

l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and 300 for Temporary Power and Lighting.

l If any of these default columns are missing, click on one of the headers, and right click.
Select Column Chooser and drag the item(s)over tto the header bar, then click OK
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8. Click OK.

9. Select the Estimate tab.

10. Click on Cost Breakdown Structure (CBS).

11. Change your Saved Views to Quote Group Setup View.

12. Create a cost item Entry Gate with a subordinate Electrical Work.

13. Assign Quote Group Electrical Work to the Electrical Work cost item.

14. Select the Quote tab.

15. Click Request For Quote (RFQ) to open the RFQ Register.

16. Create an RFQ for the Electrical Work cost item by selecting the New icon on the Actions tab.

17. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
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18. Click OK.

19. Click on the Seller Companies tab and select the following Company Names:

InEight Inc.  |  Release 20.1 Page 307 of 565

Estimate User Guide 8.5 Scope Items



l Architectural Designs

l HD Engineering Group

20. Highlight both companies and select Publish.

l Make sure the appropriate boxes are checked and fields filled out for publishing either by
fax or by email prior to publishing

21. Assuming that you’ve already received quotes back from both companies, create a Quote from
this RFQ for both companies by selecting the companies and selecting Create Quote.
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22. Click OK to close the RFQ record.

23. Select the Quote > Quotes tab to open the Quote Register.

l Note the 2 quotes that were just created for Electric Work

24. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500, which is
based on the quote you received.

25. Select the Special Terms & Conditions tab and select the Seller’s Special Terms & Conditions
radio button.
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l You now have visibility for all of scope items for this quote

26. Assuming HD Engineering is excluding certain scope items from this quote, click on the Included
checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

27. Type 150 in the Amount field for Painting Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions
total for the quote
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28. Click NEXT to move to the other Quote Record for Architectural Designs.

29. Enter a Unit Price of 3,700.

30. Press Tab to move to the Special Terms & Conditions tab and select the Seller’s Special terms
& Conditions (at right) radio button.

31. Uncheck the Inclusions checkbox for Surveying and Layout

32. Add the amount 500.

33. Click OK.

34. Select the Quote tab.

35. Open the Quote Comparison and Award form, and select the Cost Items tab.

36. Under Quote Groups, select Electrical Work.

l You will notice that scope items with inclusions and exclusions on the quotes are now
displayed in the Scope Items section. The Scope Items button needs to be pressed in the
View section of the screen
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l The total of all exclusions are now added to the Special Conditions section for each
subcontractor
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If your Special Conditions row is missing, click the Substitute Values icon on
the Action tab. You can also rearrange the sequence as desired.

l Most importantly, this comparison including scope items makes it clear HD
Engineering Group has provided a quote of $4,450, while Architectural Design’s
quote is $4,200

37. Right click on the quoted amount for Architectural Design and select Award to award the work
to Architectural Design.
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38. Click Yes, on the resulting prompt to mark the quote group as reviewed.
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l The Architectural Design’s quote is now awarded
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Lesson 8 Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the
__________________.

a. CBS Register

b. PBS

c. Quote Register

d. RFQ Register

2. On a Quote Record, No Split means

a. The quote must be combined with other quotes from the same vendor

b. All items on the quote must be purchased from that seller

c. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed

b. No quotes have been awarded for that quote group

c. There are some quotes in the quote group that contain substitute values

Lesson 8 Summary

As a result of this lesson, you can:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Run reports from the Reports menu

l Create and run reports from register forms
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9.1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

9.1.1 Adjustable Reports

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or who
the intended audience is.

For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

9.1 Step by Step 1 — Get to Know the Reports Menu

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price, and
Execution tabs.

2. Select Reports.
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3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.

l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.
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l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
reports

9.1.2 Output Settings

This section provides a more detailed explanation of the output setting tabs.

9.1.2.1 Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

9.1.2.2 Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
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Orientation, Margins, Font, and Number Format.

9.1.2.3 Report Header/Footer Settings

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
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4. You can enter your own information as desired.

9.1.2.4 Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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9.1.2.5 Save Output Settings

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.
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The following steps walk you through configuring the settings and formatting for two different reports.

9.1 Step by Step 2 — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup > Report > Resources.
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2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear
on the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.
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l You can choose to select the Hide Zero quantity/cost Resources Employments Details box if
you prefer to have your printed report not show any resources that have a dollar value of
zero

l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS position
to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item
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The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.

l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours
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12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

9.1 Step by Step 3 — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup > Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, Construction Equipment, and
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Installed Material.

8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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9.1.3 Helpful Reports

9.1.3.6 PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.

InEight Inc.  |  Release 20.1 Page 339 of 565

Estimate User Guide 9.1 Reports Menu



You can also select to show markup rate and what percentage the markup is of your cost.

9.1.4 Standard Proposal

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.
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9.1.5 CBS Details

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
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Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

9.1.6 Audit

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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Exercise 9.1 — Run a System Report

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 – 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results
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Congratulations, you have completed this exercise!
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9.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on
resource utilization and saving it as a Saved View.

9.2 Step by Step 1 — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.
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2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.

4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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6. From the Customization window, drag-and-drop the Minority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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9.2.1 Register Report Output Settings

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

9.2.1.1 Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

9.2.1.2 Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Exercise 9.2 — Create a Custom Register Report

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in the Man-Hours (Total) andMan-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results
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Congratulations, you have completed this exercise!
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Lesson 9 Review

1. The ___________ Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary

b. PBS Summary

c. Audit

2. The ___________ Report is a very important report to run during bid review to make
sure you didn’t leave anything out of the estimate.

a. CBS Details

b. Audit

c. Pay Item Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:

l Run reports from the Report menu

l Create and run reports from register forms
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LESSON 10 — DATA REPRODUCTION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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10.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

10.1 Step by Step 1 — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, in the Code field, type Infra Job Copy with your initials.

5. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

6. Uncheck the check for copying the PBS Changes Log.

7. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

10.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
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estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

10.2 Step by Step 1 — Create a Template

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.
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4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

You cannot create templates from jobs that are published to Job Tracking.

Page 358 of 565 InEight Inc.  |  Release 20.1

10.2 Templates Estimate User Guide



l A prompt appears to give your new template a Job Code

6. In the Code field, type Small Project Template [your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

7. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template from
the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

8. Select Add to existing job

9. From Select Source Job, click the dropdown arrow

10. Click Next

11. Select a job that is shown as having a Template

12. Click OK
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10.2.1 Archive and Restore Templates

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

10.2 Step by Step 2 — Archive and Restore a Template

1. Click File to open the Backstage View.

2. Select Archive / Restore.
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l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.
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8. Browse to the archived template and select it.

9. Click Open.

l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

10.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

10.3 Step by Step 1 — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.
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l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.
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l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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15. Select the checkboxes to include Mobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.
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19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use the
ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.
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10.4 COPY ESTIMATE DATA USING EDIT COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

10.4 Step by Step 1 — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).

3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).
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4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using the minimize icons of each job or utilizing Windows align functionality.

l Note that the window caption identifies the CBS Register for each job
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5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.

InEight Inc.  |  Release 20.1 Page 373 of 565

Estimate User Guide 10.4 Copy Estimate Data Using Edit Commands



l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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10.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

10.5 Step by Step 1 — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on the More Actions tab.

l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.
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7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.
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10. Click OK.

11. Click Finish on the Bid Wizard.

l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity
drivers and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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10.6 SNAPSHOTS

A job snapshot is a copy of an estimate estimate that provides read-only access to the job as it existed
at a specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

10.6.1 Snapshot Register

The Snapshot Register is where you will view individual snapshots for specific jobs.

10.6 Step by Step 1 — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.
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3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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10.6.2 Creating a New Job Snapshot

10.6 Step by Step 2 — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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10.6.3 Editing a Job Snapshot

10.6 Step by Step 3 — Edit a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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10.6.4 Deleting a Job Snapshot

10.6 Step by Step 4 — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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10.6.5 Loading a Job Snapshot

When you load an existing Snapshot, it loads into Estimate as any other job.

10.6 Step by Step 5 — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.

To identify a snapshot in Estimate as a read-only snapshot:
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l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.
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Exercise 10.1 — Data Reproduction

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from the More Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results
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Congratulations, you have completed this exercise!
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Lesson 10 Review

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

a. Scratch

b. Template

c. Import

d. Existing Job

e. Historic

f. Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost items
you want to import into your new job?

a. Template

b. Bid Wizard

c. Existing Job

d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard

b. CBS Bid Wizard

c. Template

d. Existing Job

Lesson 10 Summary

As a result of this lesson, you can:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard
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l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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LESSON 11 — EXCEL INTEGRATION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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11.3.1 InEight Estimate Workbook 397
11.3.2 Linking to and from Excel 398
11.3.3 Update Links 402

Lesson 11 Review 404
Lesson 11 Summary 404

11.1 OVERVIEW

InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.



The following sections cover exporting from InEight Estimate to Excel, linking with Excel data, and
updating links.

11.2 EXPORT TO EXCEL

InEight Estimate includes a worksheet export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data
from an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other
uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.

11.2 Step by Step 1 — Export Data to an Excel Workbook

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

l The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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l Notice that the columns are formatted, with column headers and filtering turned on

11.2.1 Cell Select

To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel
Spreadsheet.

11.2 Step by Step 2 — Cell Select

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon).

InEight Inc.  |  Release 20.1 Page 395 of 565

Estimate User Guide 11.2 Export to Excel



l This puts you in “cell-select” mode, so you can select cells to copy in the same way you
would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measure columns for all Labor resources.

6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.
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8. Click OK.

l The fields you copied from InEight Estimate paste into the spreadsheet

l To turn off the Cell Select, simply click the Cell Select Icon again and it deselects

11.3 LINKING TO EXCEL

11.3.1 InEight Estimate Workbook

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.
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l The embedded Excel workbook for the job opens.

11.3.2 Linking to and from Excel

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.
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The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.

11.3 Step by Step 1 — Link Estimate to Excel

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following
fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
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field name to display).

11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

11.3.3 Update Links

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs.  Simply select one of the following options from the Workbook drop-down
list on the Estimate tab.
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Lesson 11 Review

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. You can use the __________ tool to easily select a group of items to copy.

a. Customize

b. Workbook

c. Cell Select

d. Excel Select

3. In order to link an Excel field to InEight Estimate, the Excel field must be:

a. Named

b. Highlighted

c. Tagged

d. Selected

Lesson 11 Summary

As a result of this lesson, you can:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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LESSON 12 — SCHEDULE INTEGRATION

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Set up scheduling options

l Update schedule from InEight Estimate

l Update InEight Estimate from schedule

l Manage changes between estimate and schedule
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12.1 PRIMAVERA

12.1.1 Scheduling Options

Prior to sending information from InEight Estimate to Primavera, you need to make sure the proper
settings are in place.

12.1.1.1 Job Properties Schedule Tab

Primavera scheduling options are configured on the Setup > Job Properties > Schedule tab.

l At the top of the Schedule tab, the Integrated Schedule must be set to Primavera

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Primavera to change the duration and therefore the cost
of your cost items in InEight Estimate)

l On the Schedule tab, there are several sub-tabs that need to be set up correctly to produce
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correct data behavior and ensure the correct passing of data to Primavera

12.1 Step by Step 1 — Login Options Tab

1. On the Schedule > Login Options tab of Job Properties, select the Use these login settings radio
button.

l If pre-defined login settings were required, the Use pre-defined login settings radio button
would be selected instead

l The Instance will remain set to -Default-

l Database selection will be pmdb during training.

2. Type your user name in the User Name field.

3. Type your password into the Password field.

l You will have your own login settings specific to your company
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12.1.1.2 Mapping Options Tab

The Mapping Options tab contains options critical to downstream applications. It will have the
following settings selected by default:

1. The CBS Position Code is selected as the field to populate the Primavera WBS Code and Activity
ID fields.

2. The Manage the Primavera WBS structure in InEight Estimate… radio button is selected for
the initial push from InEight Estimate to P6.

l This means the WBS structure in Primavera will be controlled by the structure of superior
and terminal cost items in InEight Estimate.

l Selecting the other option would cause the WBS structure to be controlled in Primavera.
Only terminal cost items would be sent from InEight Estimate to Primavera and all
hierarchal structure (WBS Elements) would be created in Primavera manually

l This option can be changed later, on a job-by-job basis.

3. The Update the Project’s Planned Start Date in Primavera from the Forecast Start Date
option is checked.

l This will automatically pull the Forecast Start Date from the Job Properties > Cover Sheet
tab to become the Planned Start Date in Primavera.

You should double-check to make sure the right Start Date is defined on the
Job Properties > Cover Sheet tab.

12.1.1.3 Resources Tab

The Resources tab dictates how resources are mapped between InEight Estimate and P6.
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Section Name

1
Update Primavera Resources
from Estimate

Provides options for sending InEight Estimate resources to
Primavera.

l Typically, you would select the Update scheduled
resources only option to send only resources that are
employed on cost items

l The Update all of this job’s resources option updates
Primavera with all of the resources in your project’s
Resource Rate Register

2 Map Resource Types to
Primavera

Specify whether your resources will import into Primavera as
Resources or Roles.

3
Update Primavera Budgeted
Units when using Plug Days

Allows you to specify how to handle Budgeted Units for items
that use Plug Days.

4 Update Primavera Cost
Accounts from Estimate
Account Codes

Checking this box causes assigned account codes to import into
Primavera as Cost Accounts.

5
Update Price/Unit on
Primavera Resource
Assignments

Checking the boxes in this section will cause the Charge Rate
costs of your resources to import into Primavera along with your
resources.

12.1.1.4 Overview – Resources Tab
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12.1.1.5 Expense Costs Tab

The Expense Costs tab is useful for bringing costs in from InEight Estimate that are not connected to
resources, for example, your plugged and/or quoted cost items. This tab is optional, and it is not
required to make selections here.

12.1.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:

l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

InEight Inc.  |  Release 20.1 Page 411 of 565

Estimate User Guide 12.1 Primavera



The following steps walk you through scheduling your cost items.

12.1 Step by Step 2 — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.
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12.1 Step by Step 3 — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch
RCP Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.
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l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then
click OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.

12.1.2.6 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

12.1 Step by Step 4 — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.1.3 Update Primavera from InEight Estimate

Now that you have set up your Primavera options in Job Properties and scheduled your cost items in
the CBS, you are ready to send your project information to Primavera.

When you first update Primavera from InEight Estimate, Primavera will create a new project
automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Primavera

Data Type InEight Estimate Primavera

Project Data Job Code Project ID

Job Description Project Name

Activity Data CBS Position Code//Schedule ID WBS Code / Activity ID

Description WBS Element / Activity Name

Hours Planned Duration (Hours)

Shift and Rate Rules Activity Calendar

Cost Item Tags and UDFs Activity Codes or UDFs

Cost Category Total Cost Cost Category (custom text columns)

Resource Data Resource Code Resource ID

Resource Description Resource Name

Cost Data Resource Cost / Unit Resource Price / Unit

Cost Category Total Cost Expense Category Budgeted Cost

Tags, resource data, and cost data only update in Primavera if selected in the Job
Properties > Schedule settings.

The following steps walk you through updating Primavera from InEight Estimate to create a new
schedule.

12.1 Step by Step 5 — Update Primavera from InEight Estimate

1. From the Estimate tab, select Schedule > Update Primavera from InEight Estimate.
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l The Update Primavera From Estimate dialog prompts you to indicate what data to update
to Primavera

2. Make sure Resources and Expenses are checked. Deselect Actuals (For Job Tracking purposes) if
auto selected, then click OK.
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l An Attention prompt appears, letting you know that the job has not been saved.

3. Click Yes to save the job before updating Primavera.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take several minutes
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l When the window disappears, the update is complete

4. Open Primavera P6 (Project Management) client.

5. Log in to Primavera, using the same Username and Password that was entered on the Schedule >
Login Options tab in InEight Estimate Job Properties.
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6. In Primavera, open the project.
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7. In the Open Project dialog, expand the BID*BUILD folder.
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All projects created from InEight Estimate are created in the BID*BUILD folder by
default.

l Your available projects are sorted by their job names.

8. Select the Training Job (with your initials) so that it is highlighted, and then select Open.

l The WBS Layout displays for the project. You can see the breakdown structure imported
from InEight Estimate with durations, rolled up as specified by the Roll Up Schedule option
in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

9. Select the Resources tab to see the resources that imported for each activity, with their
associated costs.
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12.1.4 Update InEight Estimate from Primavera

You can also bring information back from Primavera into InEight Estimate. When you update InEight
Estimate from Primavera, the following information updates:

Update InEight Estimate from Primavera

Data Type Primavera InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Relationships Schedule Relationships

Hours Plugged Days
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Complete the following steps to practice updating InEight Estimate from Primavera. You will create a
scheduling relationship in Primavera, and then import the updated dates and relationships into InEight
Estimate.

12.1 Step by Step 6 — Update InEight Estimate from Primavera

1. Open your version of the Training Job project in Primavera.

l In the real world, it is likely that you would have overlapping activities, or your activities
would occur out of order, however for this example you will link all activities from finish to
start

2. Highlight all of your activities from 1-Mobilization through 6.4-Backfill RCP Pipe.

3. Right click on one of the selected rows and select Link Selected Activities to create the Finish to
Start relationship.

l You may have to select the Relationship Lines button to show the linked activities in the
graph on the right side of the screen.

4. To schedule this new relationship, select the Schedule button (or press the F9 key).

5. On the Schedule Project window, keep the default settings and select the Schedule button.
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6. To update InEight Estimate with this change, go back to InEight Estimate and select Estimate tab.

7. Select Schedule > Update Estimate from Primavera.

8. On the Update InEight Estimate from Primavera prompt, keep the default Update the estimate
to stay in synch with the schedule selected, then click OK.
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9. On the Schedule Setup View, you can see the Start and Finish dates updated from Primavera.
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12.1.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.1.5.7 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab.

For example, your 10” PVC Pipe activity may have extra days in the schedule due to the delivery date
of the pipe material, but you don’t want those extra days to drive the costs in your estimate, since your
crews won’t be working on the activity on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

12.1 Step by Step 7 — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

12.1.5.8 Update Primavera with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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12.1 Step by Step 8 — Update Primavera with InEight Estimate Changes

1. In the Training Job from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below:

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your
unit costs stay intact, then click OK.

3. From the Estimate tab, select Schedule > Update Primavera from InEight Estimate to send the
changed hours to Primavera.
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l The Update Primavera From InEight Estimate dialog prompts you to indicate what data to
update to Primavera

4. Make sure Resources and Expenses are checked, then select OK.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take a few minutes
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l When the window disappears, the update is complete

5. Open Primavera (P6 Web Client).

6. Open the Training Job project.

7. On the Activities screen, compare the Planned Duration to the Days (Duration driven) in InEight
Estimate for Excavate-Install-Backfill Pipe.

l The Primavera scheduled duration should have changed from 4.65 days to 7 days to match
the updated duration in InEight Estimate for Excavate-Install-Backfill Pipe

l You will also notice a change in days for Excavation after changing the T/O Quantity in
InEight Estimate
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8. To schedule this change in Primavera, select the Schedule button (or press the F9 key) and select
the Schedule button on the Schedule Project window.

9. Your start and finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule > Update InEight Estimate from Primavera to update InEight Estimate with the new
dates.
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Exercise 12.1 — Manage Changes Between Estimate and Primavera

As changes occur during the estimating process, you can keep the estimate and schedule in sync
through schedule integration. In this exercise, you will practice making changes between the
estimate and schedule. Complete the following steps:

1. Open the Training Job and open the CBS Register.

2. Check the box in the Schedule Plug Days column for the Install RCP Pipe.

3. Change the Plug Days for Install RCP Pipe to 8 days.

4. Update Primavera from InEight Estimate.

5. Open the Training Job project in Primavera and confirm the Planned Duration (you may
need to change your view to see this column) changed to 8 days.

6. In Primavera, change the Planned Duration for Backfill RCP Pipe to 12 days.

7. Schedule the changes in Primavera (Schedule button or F9).

8. Update InEight Estimate from Primavera.

You should end up with the following results

Cost item 6.3 Install RCP Pipe is now showing 8 Plug days in Primavera.
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Cost item 6.4 Backfill RCP Pipe should have 12 plug days in InEight Estimate.

Congratulations, you have completed this exercise!
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12.2 MICROSOFT PROJECT

12.2.1 Set Up Scheduling Options

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

12.2.1.1 Job Properties Schedule Tab

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

l At the top of the Schedule tab, the Integrated Schedule must be set toMicrosoft Project

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

12.2.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:

Page 434 of 565 InEight Inc.  |  Release 20.1

12.2Microsoft Project Estimate User Guide



l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

The following steps walk you through scheduling your cost items.

12.2 Step by Step 1 — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
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press Tab.

12.2 Step by Step 2 — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch
RCP Culvert Class.

To schedule all cost items, highlight the JOB row
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4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then
click OK.

l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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12.2.2.2 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

12.2 Step by Step 3 — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.2.3 Update Microsoft Project from InEight Estimate

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.

When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project

Project Data Job Code Project Name

Activity Data

CBS Position Code 01 – CBS Position Code

Description Description

Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.

12.2 Step by Step 4 — Update MS Project from InEight Estimate

1. From the Estimate tab, select Schedule > Update Project from InEight Estimate.
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l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project

l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
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Cover Sheet tab (these will change as activity relationships are defined)

12.2.4 Update InEight Estimate from Microsoft Project

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Hours Hours

Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.
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12.2 Step by Step 5 — Update InEight Estimate from MS Project

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule > Update InEight Estimate from Project.
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l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.

12.2.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.2.5.3 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity
may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want
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those extra days to drive the costs in your estimate, since your crews won’t be working on the activity
on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

12.2 Step by Step 6 — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

12.2.5.4 Update Microsoft Project with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.

12.2 Step by Step 7 — Update MS Project with InEight Estimate Changes

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.
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l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your
unit costs stay intact

3. From the Estimate tab, select Schedule > Update Project from InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
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adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule > Update InEight Estimate from Project to update InEight Estimate with the new
dates.
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Lesson 12 Review

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit

b. Expense Costs

c. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs

c. Resource data

d. Cost data

e. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

Lesson 12 Summary

As a result of this lesson, you can:

l Set up scheduling options

l Update Schedule from InEight Estimate

l Update InEight Estimate from Schedule

l Manage changes between estimate and schedule
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LESSON 13 — CASH FLOW

Lesson Duration: 25 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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13.1 CASH FLOW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Overview – Cash Flow Form

Section Description

1
The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time
l The left y-axis measures amounts
l The right y-axis measures quantities (when resource utilization is displayed)
l All graphs depicted on the Cash Flow form can be displayed based on Pay Quantity or

Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.
l You can display total costs and price or specific cost categories
l You can also set the display settings to report on Resource Utilization

3
Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost of
money.

4 Click the Excel icon to export the numerical data represented on the graph into an Excel
spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset Zoom
button to restore the graph to its original state.
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13.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.
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13.2.0.1 Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

13.2 Step by Step 1 — Cash Flow Options Setup

1. In the E101 – Training Job, from the Estimate tab, select Setup > Job Properties > Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.

13.3 CASH FLOW DISPLAY SETTINGS

13.3.1 Cost Items and Cost Categories

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings icon in the Tools section.
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Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day, Week,
Month, Quarter, and Year.

3

Under the Cost Items section, you can select:
l Total Cost (Forecast):  The total cost of your scheduled cost items, based on when

your costs are accrued (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when the
revenue is earned (when your cost items are scheduled). This is displayed as a dashed
line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items, reflecting
the cost timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting the
revenue timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total Price –
Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the settings you
specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to display.
l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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13.3.1.1 Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

13.3 Step by Step 1 — Cash Flow Display Settings Set Up

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date
of your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

13.3.2 Resource Utilization

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage
times for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings in the Tools section of the Actions menu.
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13.3.2.2 Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

13.3 Step by Step 2 — Resource Utilization Display Setup

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.
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6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.
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10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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Lesson 13 Review

1. Under what cash flow form can you set up your revenue and cost timing?

a. Cash Flow Options

b. Display Settings

c. Worksheet

d. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:

a. Total Cost (Forecast)

b. Total Price (current)

c. Total Cost (Forecast) – Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description

b. Resource Type

c. Resource Code

d. Description

e. Wage Zone

f. Organizational Category

Lesson 13 Summary

As a result of this lesson, you can:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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l Use the Trench Calculator
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Lesson Topics

14.1 Haul Calculator 466
14.2 Trench Calculator 470

14.2.1 Trench Calculator – Trench Tab 471
14.2.2 Trench Calculator – Pipe Tab 474
14.2.3 Trench Calculator – Beddings Tab 476

Exercise 14.1 — Trench Calculator 479
14.3 In-Field Calculator 482
Lesson 14 Review 484
Lesson 14 Summary 484



14.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

14.1 Step by Step 1 — Haul Calculator – Calculate Quantity of Trucks

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.
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10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter a Work Efficiency of 90 percent.
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l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

14.1 Step by Step 2 — Haul Calculator – Calculate Total Duration

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours
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7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2

14.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)

l Total pipe to purchase
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l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data
is included with the data being copied. When a cost item is copied to the clipboard,
Trench Calculator variable data is also included.

14.2.1 Trench Calculator – Trench Tab

The following steps walk through using the Trench Calculator to take-off excavation volume.

14.2 Step by Step 1 — Trench Calculator – Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:

l LL2  Laborer – 1

l LO2  Operator Class 2 – 1
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l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.
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7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.

11. Enter a Backslope of 45 degrees.

12. Define the Material Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

InEight Inc.  |  Release 20.1 Page 473 of 565

Estimate User Guide 14.2 Trench Calculator



14. Click Save Configuration to Library and save the Trench calculator as Trench Example with
your initials.

15. Click OK.

14.2.2 Trench Calculator – Pipe Tab

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.

14.2 Step by Step 2 — Trench Calculator – Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

Page 474 of 565 InEight Inc.  |  Release 20.1

14.2 Trench Calculator Estimate User Guide



3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:
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13. Click Save Configuration to Library and save the Trench calculator as Trench Example with
your initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

14.2.3 Trench Calculator – Beddings Tab

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

14.2 Step by Step 3 — Trench Calculator – Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.
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3. Add the following resources:

l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities

Page 478 of 565 InEight Inc.  |  Release 20.1

14.2 Trench Calculator Estimate User Guide



Exercise 14.1 — Trench Calculator

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

2. Give the cost item a quantity and unit of measure of 1640 Linear Feet.

3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet

Trench depth 10 feet

Hinge elevation 5 feet

Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)

l Do NOT check the box to bring in volume shrinkage.

5. Select the MPR36 material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3

Bedding material resource (Tons) MASAND
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Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor) 76 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results
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Congratulations, you have completed this exercise!
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14.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the
value.

14.3 Step by Step 1 — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.
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5. Press the Tab key and it calculates the result.
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Lesson 14 Review

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks

c. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate ___________ values.

a. Trench

b. Pipe

c. Bedding

d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b. –

c. =

d. (

Lesson 14 Summary

As a result of this lesson, you can:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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Lesson Objectives

After completing this lesson, you will be able to:

l Explain what a cost item assembly is and why it is used

l Create and edit a cost item assembly

l Employ a cost item assembly
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15.1 COST ITEM ASSEMBLY OVERVIEW

15.1.1 Overview

Cost Item Assemblies utilize predictive models to quickly and accurately estimate elements of a job
that can be repetitive in nature on a single job or from job to job. They use parameter driven
estimating to create cost items. They use created parameters and mathematical calculations to
incorporate quantity takeoffs and estimate quantification into cost items. A cost item assembly will
output fully populated cost items directly into the project CBS. The inputs are dimension values and
specification sections, while the output is cost items.

Cost Item Assemblies accomplish the following:

l Model a construction system or component that is quick and easy to employ

l Promote a consistent process of estimating among various users

l Enable less experienced users to more efficiently create an estimate

l Provide good visibility into the assumptions and calculations made to obtain the results

l Provide the flexibility to easily adjust model assumptions and account for varying project
requirements from estimate to estimate

All the following can be done with Cost Item Assemblies:

l Assembly employments can be re-opened to modify inputs

l Assemblies can be stored in the Library and imported like resources

l Assemblies can be copied and pasted between projects

l Assemblies can be created from existing project cost items

l Assemblies can be modified for project specific needs

l Assemblies can be modified and employments updated in the project

l Employed assemblies can become permanent cost items by deleting the link

l Assemblies can be created for either metrical or imperial units

15.1.2 Users

There are typically two types of users that work with Cost Item Assemblies:
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l The power user, someone like the lead estimator, creates the cost item assemblies

l The end user uses the created assemblies

User Function

Power User

This user can determine what questions need to be answered to
create a standard construction system, and how specifically to use
those answers in determining the systems quantities, cost and
resources to be applied in the estimate.
Many companies have spreadsheets that they have created for
estimators in the organization to use in estimating specific types of
work. If you are the person that often creates or enhances those
spreadsheets, you probably fall into the category of being a user that
will create Cost Item Assemblies.

End User This is sometimes a less experienced estimator that will benefit from
being provided a set of questions to answer because it can help the
estimator develop an understanding for the way the work is
estimated and provide them with guidance in gathering the right
information.
The use of Cost Item Assemblies is not exclusive to less experienced
estimators, however. They can be used by anyone involved in the
estimating process that wants to quickly create an estimate for a
scope of work in a consistent and repeatable way. Cost Item
Assemblies can be a great way to initialize an estimate and give the
estimator more time to focus on analyzing the job and considering
different ways of approaching the work.

User Types

15.1.3 Navigation / Data Blocks

The use of data blocks in the Cost Item Assembly Register allows you to set up a layout that works best
for you.

The data blocks in the Cost Item Assembly Record are:

l Cost Items

l Inputs

l Calculations
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l Notes

l Setup

l Tables

l Sub Assemblies

The Default Data Block view looks like the following:

15.1.4 Move Data Blocks

To move Calculations onto the screen, simply click on the name and drag it until the following options
appear:
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Next, choose where to place it on your screen:

The calculations data block now appears on the screen.
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15.1.5 Add and Remove Data Blocks

To look at Setup and Tables, click on the tabs to view them.

To get rid of the Notes screen, simply press the X, and to bring it back, click on Default Data Blocks in
the ribbon.
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15.2 COST ITEM ASSEMBLY CREATION

15.2.1 Create a Cost Item Assembly Record

Cost Item Assemblies allow you to create intelligent construction systems to automatically estimate
various scopes of work, based upon a user providing specification and dimension variables. You can
create multiple Cost Item Assemblies and maintain a library of construction systems that are used
throughout the estimating department. When creating an assembly, it’s helpful to have a solid
understanding of the various inputs that will be used and how those inputs will be used to influence the
resulting collection of cost items.

Cost Item Assemblies are created by entering a code and description for the assembly. Both fields can
be changed at any time.

Scenario

One scope of work that is part of the estimate is a ductbank. This ductbank work entails
excavating, laying the conduit, and then either backfilling it with concrete or soil depending on
the location, and all conduit runs consist of two conduits. You want to estimate the cost and hours
for this work using a cost item assembly.

Page 492 of 565 InEight Inc.  |  Release 20.1

15.2 Cost Item Assembly Creation Estimate User Guide



15.2 Step by Step 1 — Create a Cost Item Assembly Record

1. From the Setup tab, click on Cost Item Assemblies.

2. From the Actions tab, click on New.

3. In the Code field, type TEST – Your Initials.

4. In the Description field, type Test Cost Item Assembly - Ductbank.

5. In the bottom right corner, click OK.
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l Notice that your Cost Item Assembly now shows up in the Cost Item Assembly Register

15.2.2 Workflow

There is a standard workflow for building cost item assemblies .

1. Define the desired output from an assembly (cost items).

2. Decide what questions the estimator will be required to answer (and what assumptions you want
to set).

3. Create input tables for user selections.

4. Create expressions to provide the required results to populate the cost items.

15.2.3 Build Cost Item Assembly Record

Once your Cost Item Assembly has been created, it is time to build the assembly. To begin, you first fill
out the setup information, then you use the remaining data blocks to build the assembly record.

The fields in the Setup tab can be filled with unique names, choice of pull-downs or left blank. The
fields on the Setup tab include:

l Assembly file

l Geographic Areas

l Wage Zone

l Org. Category
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l Last Changed By is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l Last Changed On is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l The Tag and User Defined field can be filled in by the user

The first four fields are used the same way resource attributes are used to filter which resources are
imported from the master library into a project. These will appear on the cost basis tab of job
properties as filters to determine which cost item assemblies you import into a new estimate.

15.2 Step by Step 2 — Cost Item Assembly Set Up

1. Select your assembly from the list and click Open from the ribbon.

2. In the bottom right corner, click on the Setup tab.
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3. In the Assembly File drop-down, select Standard Cost Item Assembly File.
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4. Select a Geographic Area and Org. Category.

5. In the Tag 1 drop-down, select Concrete.
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6. In the Tag 2 drop-down, click the Add icon.

7. Enter the following, then click OK.
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15.2.4 Cost Items

The Cost Items data block is used to create cost item breakdown structure, where you can assign the
default values and resource employments and link the results of the calculated values to the
appropriate cost item and resource employment fields. This is where you build a framework of cost
items that you want as output from this assembly.

Cost Items for a Cost Item Assembly are created within the Cost Item Assembly Record, not in the CBS
Register.

There will be at least one cost item with the following default values which you can override.

l Default Description is equal to the Assembly Description

l Default Forecast (T/O) Qty = 1

l This is the top-level cost item in the assembly. Any additional cost items will need to be created
as subordinates to this cost item

After you complete the values in the Cost Items data block, the steps included in
the Calculations data block need to be completed prior to linking any values to the
cost items.
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This data block has the same functionality as the CBS register; double-clicking one
of the cost items or selecting one of the cost items and choosing Open from the
menu will open the Cost Item Record. To quickly perform this work, you can easily
copy cost items from the CBS Register and paste them into the Cost Items data
block of the Cost Item Assembly Record.

15.2 Step by Step 3 — Create Cost Items in an Assembly

1. Click X on the pop up.

2. From the Cost Items data block, right click on your cost item and select Insert Subordinate.
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3. Insert 4 subordinates.
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4. Enter the descriptions and units of measure as follows:

15.2.5 Inputs and Tables

The Inputs data block is where you define the questions that will be asked of the user when they
employ a Cost Item Assembly. Inputs can be value-type or table-type inputs and validation rules can be
specified for value-type inputs such as minimum or maximum values that are acceptable, or default
values that appear when the Cost Item Assembly is employed. These Inputs will be the parameters
used in calculations to drive the Cost Item Assembly outputs.

Tables are used for reference data and can provide functionality similar to a lookup field in excel.
Tables may contain account codes, production rates, or other reference fields and can be imported
from the Library or copied from one assembly to another. Tables can be assembly specific, project
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level (Standard), or Enterprise (Library) level (Master Standard). You can populate tables from a
project specification list.

15.2 Step by Step 4 — Create Input Values

1. Navigate to the Inputs data block. In the first empty field under Variable Name, type Length,
then press Tab.

The Variable Name is how the calculations will reference the input values.

l The Display Order field can be set to control the order in which you are prompted to
provide the input values

2. Select the Description field and type Ductbank Length (ft), then press Tab.
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3. In the Input Type field, select Value from the drop-down list. In the Default Value field, type 100.

4. Fill out additional fields as shown below:

15.2.5.1 Data Validation

The Data Validation field determines what type of data validation is enforced when the Cost Item
Assembly is employed. This field is enabled only when the Input Type is Value. The data validation
options are as follows:
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Selection Description

None No validation is enforced, and any numeric value is permissible.

Equal Permits the entry of a value that is equal to the value entered in the Value/Minimum
field.

Not Equal
Permits the entry of a value that is not equal to the value entered in the
Value/Minimum field.

Greater
Than

Permits the entry of a value that is greater than the value entered in the
Value/Minimum field.

Greater
Than or
Equal

Permits the entry of a value that is equal to or greater than the value entered in the
Value/Minimum field.

Less Than Permits the entry of a value that is less than the value entered in the Value/Minimum
field.

Less Than
or Equal

Permits the entry of a value that is less than or equal to the value entered in the
Value/Minimum field.

Between Permits the entry of a value that falls between the range of numbers defined by the
values entered in the Value/Minimum field and the Maximum field.

Not
Between

Permits the entry of a value that does not fall between the range of numbers defined by
the values entered in the Value/Minimum field and the Maximum field.

15.2 Step by Step 5 — Create Input Values from a Table

1. In the bottom right corner of the Cost Item Assembly Record, click on Tables.

2. Right click in the Table Code field and select New.

Page 506 of 565 InEight Inc.  |  Release 20.1

15.2 Cost Item Assembly Creation Estimate User Guide



3. In the Code field, type CONC – Your Initials, and in the Description field, type Concrete Types.

4. In the Columns section, enter in the following column names and descriptions, choosing the Text
Type.
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5. Click OK in the bottom right corner.

6. In the Tables section, enter in the following data for the Concrete resource codes and types:
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7. Click OK in the bottom right corner.

8. Add the following input, selecting Table for the Input Value from the drop-down.

9. From the Table drop-down list, select your CONC table.
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15.2.5.2 Standard Tables

In the Setup tab, you can create standard tables for the project. These are created exactly like tables
within the Cost Item Assembly Record. All users in the project have access to the standard tables.
These tables can be copied and pasted into the Cost Item Assemblies’ tables. You can create, edit, or
delete standard tables from the Standard Table Register. You can copy Standard tables from the
library, to the library, and from another job.

15.2.6 Conditional Inputs

Conditional input expressions can include variables that reference other input values or ask simple
Yes/No questions. This allows the user to provide answers to inputs, which are then used to determine
if the user is asked to provide more answers for additional inputs. The variable Default Value is used in
the conditional input expression, so the input is always hidden when the Cost Item Assembly is initially
employed. Therefore, the Default Visibility checkbox is not selected, and when you create an estimate
and employ the Cost Item Assembly in the Cost Item Assembly Inputs view, the conditional input is
hidden.

You can then provide information and enter a dimension or a response to a question. Note that:

l If the value entered changes the expression result to True, the conditional input shows

l If you want to see all the inputs in a Cost Item Assembly even if their conditions are not currently
evaluating to True, you can click View in Cost Item Assembly Inputs, and then select Show Hidden
Inputs. This will display all the conditional inputs for the Cost Item Assembly

l To make it easier for users to select data from tables, you can hide unnecessary table columns in
the Table Row Selection Register

l In both Cost Item Assembly Register and Standard Tables Register, go to the Columns data block
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and clear the Default Visibility checkbox to hide columns in the table

More user tags and user defined fields are available on the Cost Item Assembly > Inputs data block
related to a group of variables or with other similarities. A Standard View also exists, so you can define
saved views to make use of the additional tags and fields.

15.2 Step by Step 6 — Set Conditional Inputs

1. Create a new input as follows, choosing Table as the Input Type, and selecting Standard Table
from the drop-down.

2. Set the Default Value of the CONC variable as No, then click OK.
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3. In the Visibility Condition field for the CONC TYPE variable, click the fx button.

4. In the Formula Editor, and from the Fields section, double click [CONC.CODE].
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5. In the Operators field, double click on the ‘==’

6. In the Formula Editor, type ‘Yes’.

7. Click OK.
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l Notice that the Default Visibility field for CONC TYPE becomes unchecked

l This means that only when the answer to Is Concrete required is Yes, the CONC TYPE input
will become visible; otherwise, it will stay hidden

8. In the Tag 1 fields for CONC TYPE and CONC, select Concrete.
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9. In the Find field under Inputs, select Tag 1.

10. Begin typing in Concrete and notice that the CONC TYPE row becomes highlighted.
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15.2.7 Calculations

Calculations are values produced from expressions that utilize hard values, input values, and lookup
values. They can be numerical, Boolean, and/or character expressions. These calculations will provide
the method to produce values to use with the cost item output of the assembly. Variable names can
contain these special characters:

l A-Z

l 0-9

l _

l ? (Null)

15.2.7.3 Formulas

The Formula field enables you to create your own custom expressions. You can take assembly inputs
and calculate results. Calculation results may be used in other calculations or linked to an assembly’s
cost item register field values. Formulas can be created with numbers, math operators (e.g., + or – for
addition or subtraction), input variable values or other calculation results, table lookup values, or any
number of functions that are built into the Formula Editor.

The following formula shows an example of how to calculate the cubic foot volume of concrete in a 10’
wide by 15’ long by 6” thick slab on grade. The resulting answer is 75 cubic feet.

To calculate the same volume in cubic yards (there are 27 cubic feet in a cubic yard), the formula can
be rewritten as follows. The resulting answer is 2.78 cubic yards.
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15.2.7.4 Variables

Variables are placeholders for values that can be changed based upon user input or calculation results,
and they can be used to simplify a complex formula. Variables require a name that is unique within the
Cost Item Assembly, and the syntax for referencing a variable in a formula is to enclose the entire
variable name in [brackets]. Using the preceding example, a calculation named [VOL_CUFT]
determines the cubic foot volume of 75. The second formula then references the value stored in the
variable [VOL_CUFT] and divides it by 27 to calculate the cubic yard volume of 2.78.

Input variables are also used to store user inputs as described above. In the following example, three
inputs are created in the Inputs section of the Cost Item Assembly and employing this Cost Item
Assembly will prompt the user to provide the values for the width, length and thickness of the concrete
slab, those values are stored in the variables named [WIDTH], [LENGTH] and [THICK] respectively.

The [VOL_CUFT] calculation in the following example is the same as in the preceding example, but
replaces the 10 foot, 15 foot, and 6 inch values with the variable names, which you would provide
when the Cost Item Assembly is employed.

As in the preceding example, the [VOL_CY] calculation takes the result of the [VOL_CUFT] calculation
and divides by 27 to convert the volume from cubic feet to cubic yards.
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15.2.7.5 Functions

Functions can be used to expand the power of a formula by performing special types of operations on
the formula’s values. Functions are most commonly used by the name of the function, followed by the
values that the function will use to perform the special calculations.

As an example, the Ceiling() function can be used to take the result of a calculation and round it up to
the nearest whole number. In using the concrete slab example from above, the calculation [VOL_BUY]
will take the result of the [VOL_CY] calculation and round it up from 2.78 CY to 3.00 CY using the
syntax Ceiling([VOL_CY]), which represents the amount of concrete you would want to purchase for
this work.

15.2.7.6 Null Value

Creating valid formulas can be challenging when calculations start to become more complex.
Improper referencing of variables, incorrect spelling of functions, or invalid mathematical operations
are all examples of ways in which a formula expression can be invalid. When a formula results in an
invalid expression it will return a NULL value. A NULL value is displayed using a ‘?’ character and will
preclude you from employing the Cost Item Assembly in the job. In the following example, a formula
that divides any number by zero generates a mathematically invalid result and is indicated by the ‘?’
character.

15.2.7.7 Formula Editor

The Formula Editor is a tool you can use to assist in the creation of validated formulas that correctly
reference variables and ensure the use of proper syntax. Select the fx button to open the Formula
Editor.
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Element Description

1
Expression
Box

Type your formula expression here or add expression elements by double
clicking items in the Expression Values section as described below.

2 Expression
Elements

Click on an element type to view its categories in the Expression Values list (3).

3
Expression
Values

Double-click a value to add it to the Expression Box.
l If Functions is the selected Expression Element, a drop-down list of various

categories of functions will be displayed so the list can be filtered making
it easier to find the desired function.

4 Information
and Help

When an expression is selected from the Expression Values list (3), an
explanation of that expression and how it is used will appear in this window.

l If Fields is the selected Expression Element (2), the Expression Values
section will list all the available variables used in the Cost Item Assembly,
as well as displaying the variable type and the Description as provided by
the user in the Description Field of the indicated Input or Calculation
variable

l If Constants is the selected Expression Element (2), then choosing any of
the values in the Expression Values section will provide a brief explanation
of the constant

l If Operators is the selected Expression Element (2), then choosing a
mathematical operator in the Expression Values section will display a
brief description of what the operator does

l If Functions is the selected Expression Element (2), choosing a Function in
the Expression Values section will display the selected functions syntax as
well as a brief description of how the function is intended to work

Overview - Formula Editor
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Within the Formula Editor, you can use tables to provide reference data for use in calculations. For
example, the following illustration shows a table that stores values for various Concrete Strengths
along with their associated resource code values.

15.2 Step by Step 7 — Create Calculations

1. Drag the Calculations data block into view.
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2. In the Variable name field, type Volume, then press Tab.

The Variable Name field in the Calculations section will be the name that other
Calculations can refer or link to and this name must be unique within the context of
the Cost Item Assembly, and unique with respect to input variable names.

3. Enter the Description Ductbank Volume, then press Tab.

4. In the Formula field, select the fx formula editor button.
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5. Select the Field values and Operators as indicated below to create the displayed formula, then
click OK.

l Notice that the Default Result auto calculates using the calculation and input values
provided

6. In the blank row under the Variable Name field, type Conduit and enter the Description Conduit
Length, then click the fx button to open the formula editor.
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7. Select the Fields value and Operators as indicated below to create the displayed formula, then
click OK.

8. In the blank row under the Variable Name field, type Volume2 and enter the Description
Conduit Volume, then click on the fx button to open the formula editor.

9. Enter the following formula, using the PI() function from the Functions > Math tab, the radius
and length from the Fields tab, and the available Operators tab, then click OK.
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10. In the blank row under the Variable Name field, type Volume3 and enter the Description
Backfill/Concrete volume, then click on the fx button to open the formula editor.

11. Enter the following formula, selecting the already created calculations from the Fields section.
Click OK.
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12. In the blank row under the Variable Name field, type Concrete and enter the Description
Concrete type, then click on the fx button to open the formula editor.

13. Enter the following formula, selecting the table value from the Fields tab, then click OK.
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l A default result will not appear because a value from the table has not yet been chosen.

15.2.8 Notes

Notes can be utilized to provide guidance to you on how to use the Cost Item Assembly or provide
further clarification on what the various inputs are requiring or how the calculations are being
performed. This field supports rich text editing, meaning users can copy and paste from an editing tool
various graphics or formatted text such as bold text, bulleted or numbered text, hyperlinks to websites,
or various fonts. The Notes data block is displayed on the right side of the Cost Item Assembly Record
screen.
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15.2 Step by Step 8 — Add to the Note Section

1. Click on the Notes tab in the bottom right corner.

2. In the Notes text box, type Ductbank Notes.

3. Right click within the notes section and select Hyperlink.
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4. Type in a link to your SharePoint or document sharing site, then click OK.
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l Note how the hyperlink appears in the notes section.

5. Still in Notes, copy a picture or drawing from your computer, then Paste it into the notes section.
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15.2.9 Linking Calculations to Cost Items

The results of calculations can be assigned to any number of different fields in the Cost Items data
block of the Cost Item Assembly record. It is common to link dimensional calculations to the Forecast
(T/O) Quantity fields of various cost items, but calculation results can be linked to many other fields
such as Productivity fields, Description fields, and even Resource Employment fields such as Quantity
or Code. You can link multiple cost item fields to a single calculation by holding the CTRL key. To link a
calculation to a cost item, you right click on the cost item field and then either select to link to the
calculation result from the context menu or from the ribbon.

15.2 Step by Step 9 — Link Calculations to Cost Items

1. Expand your Cost Items window so that you can see all the cost items.

2. Right click on the Excavate Ductbank Forecast (T/O) Quantity field and select Link this field to
Calculation Result.
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You create calculations prior to linking the values field. The linking of calculation
results is similar to linking to Excel values except all linked values update
automatically.

3. Select VOLUME, then click OK.
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l Note how the Forecast (T/O) Quantity field is now populated with a linked quantity

4. Right click on the Install Ductbank Conduit Forecast (T/O) Quantity field and select Link this
field to Calculation Result.

5. Select CONDUIT, then click OK.
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6. Select the Forecast (T/O) Quantity field for Pour Concrete, hold down CTRL, and select the
Forecast (T/O) Quantity field for Backfill.

7. Right click and select Link this field to Calculation Result.

8. Select VOLUME3, then click OK.
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9. In the Inputs data block, select the Default Value field for the CONC TYPE input.

10. SelectMC2000, then click OK.

Page 534 of 565 InEight Inc.  |  Release 20.1

15.2 Cost Item Assembly Creation Estimate User Guide



l Notice that this value is now populated in the Default Value field.

11. Navigate to the Calculations data block.

l Note that the Default Result field is now populated

12. In the Cost Items data block, right click in the Optional Code field for the Pour Concrete cost
item, and select Link to Calculation Result

13. Select the CONCRETE calculation, then click OK.
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l Note how the optional code for Pour Concrete is now populated

15.3 COST ITEM ASSEMBLY EMPLOYMENT

When an estimator wants to estimate a scope of work, they can use any available Cost Item Assemblies
that have been included in the job. Cost Item Assemblies are employed in the CBS Register in much the
same way a resource is employed on a cost item. Cost Item Assemblies can be imported into a project
from the Library via the Setup > Job Properties > Cost Basis tab in the same way that resources can be
brought in.
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15.3.1 Employment

Employing cost item assemblies comes after they have been created by a lead estimator typically.
Employing an assembly means an estimator selects a specific assembly to insert into the CBS register
as if adding a new cost item. The estimator will be prompted to provide all the inputs or accept the
default assumptions required for that assembly.

15.3.2 Job Properties

Cost Item Assemblies can effectively be used as a starting point for various components of an estimate.
You can import job specific cost item assemblies by navigating to the Setup menu and selecting Setup >
Job Properties > Cost Basis > Cost Item Assembly.

You can also import cost item assemblies into the Library the same way as doing it from within a job.
You can access the Master Cost Item Assembly Register by navigating to the Library > Cost Item
Assembly Register.
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15.3.3 Insert Cost Item Assemblies

Once your Cost Item Assemblies are created, the cost items must be inserted into the CBS Register.
They can be inserted as a subordinate or new cost item anywhere in the CBS hierarchy. To do so, you
right click on the position code where you want to place the cost item assembly and select to either
insert the assembly as subordinate cost items or as new cost items.

Once the cost items are inserted into the CBS, you can hover over Forecast (T/O) Quantity to see the
associated calculation.

15.3 Step by Step 1 — Insert Cost Item Assemblies

1. Navigate to the CBS Register.
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2. Right click on the first cost item in the hierarchy and select Insert Cost Item Assembly as
Subordinate.
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3. Select your Cost Item Assembly, then click OK.

4. Click OK again.

l Your Cost Item Assembly is added to the bottom of the CBS

15.3.4 Edit an Employed Cost Item Assembly

Employed Cost Item Assemblies are read-only cost items in the CBS register, but the inputs that were
provided by the user to create the cost items can be modified to update the resulting cost items. If you
change one variable in the cost item assembly, it will automatically update all associated cost items.

You can update the values of an Employed Cost Item Assembly in two ways:
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l From the CBS Register

l From the Cost Item Assembly Register

15.3.5 From the CBS Register

You can edit the entire Cost Item Assembly from within the CBS Register.

15.3 Step by Step 2 — Edit an Employed Cost Item Assembly from the CBS
Register

1. Right click on your Excavate Ductbank cost item and select Edit Cost Item Assembly Inputs.
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2. Maximize your screen.

3. Change the Length input value to 120.

4. Click OK.

l Notice how all the quantities for the cost items using the input Length change

15.3.6 From the Cost Item Assembly Register

You can navigate back to the Cost Item Assembly Register, select your Cost Item Record, and make any
changes there. Once the Cost Item Assemblies have been employed, to update the cost items with any
changes made in the Cost Item Assembly Register, you need to go back to the CBS Register to update
the cost items. You follow the same steps as above except you do not actually change anything in the
edit window, you just click OK to see the updated changes.
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15.3.7 Advanced Options

The following step by step demonstrates some advanced options within Cost Item Assemblies, such as
conditional inputs and functions.

15.3 Step by Step 3 — Advanced Options

1. Navigate to your Cost Item Assembly Record.

2. In the Calculations data block, click on the formula editor for the “Volume” calculation.

3. Using the Functions tab, select the Round function and put your existing formula within its
parenthesis, then click OK.
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l You now see a rounded number in the Default Result field

4. You now see a rounded number in the Default Result field

5. Do the same for the Volume2 and Volume3 calculations.

6. Create a new calculation. In the Variable Name field, type Include_Conc, enter Include
Concrete? in the Description field, then click on the fx button to open the formula editor.

7. Using the Iif(, , ) function from the Functions tab, and the existing Volume3 calculations from the
Fields tab, enter in the following formula, then click OK.
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8. Navigate to the CBS Register.

9. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.
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10. On the CONC input, select the ellipses next to the Default Value.
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11. Select Yes.

12. Click OK.
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l Note how the conditional input CONC TYPE is now displayed

13. Click OK.

14. Navigate back to your Cost Item Assembly Record.

15. In the Cost Items data block, right click on the Pour Concrete Forecast (T/O) Quantity field.

16. From the ribbon, click the Unlink from Calculation Result option.

17. Now click Link to Calculation result.
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18. Select the INCLUDE_CONC calculation, then click OK.

19. Right click on the Pour Concrete Optional Code field.

20. From the ribbon, click the Unlink from Calculation Result option.

21. Navigate to the CBS Register.

22. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.

23. Click OK.

24. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.
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25. Change the default value of CONC to No.

26. Click OK.

27. Click OK again.

l Notice that your Pour Concrete cost item now disappears

15.3.8 Breaking the Link to a Cost Item Assembly

To ensure that the logic used in the calculation of a Cost Item Assembly is retained, employed Cost
Item Assemblies are not directly editable in the CBS Register. To customize the results of an employed
Cost Item Assembly, you can disassociate it from the originating Cost Item Assembly logic as per the
following steps.

15.3 Step by Step 4 — Break the Link to a Cost Item Assembly

1. Right click your Excavate Ductbank cost item and select Break Cost Item Assembly Link.
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2. On the resulting Attention prompt, click Yes.
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3. When prompted about changing the Quantity Driver to Superior CI, click Yes.

l Note that the hyperlinks disappear, and the link has been broken
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Exercise 15.1 — Creating and Employing a Cost Item Assembly

Now that you have covered the key tasks related to cost item assemblies, you can practice creating
one on your own. You can use your own project (if available) or the training project used in this
lesson.

1. Create a cost item assembly with two cost items.

2. Create inputs and calculations and link them to the cost items in your assembly.

3. Employ the assembly in the CBS Register.

4. Break the cost item’s link to the assembly.

Congratulations, you have completed this exercise!
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15.4 COST ITEM SUB-ASSEMBLIES

With the Sub-Assemblies in the Cost Item Assemblies form, you can easily create and maintain cost
item assemblies that model construction systems and contain multiple complex calculations. Sub-
assemblies enable the Cost Item Assemblies feature to be more modular, allowing you to maintain
smaller, simpler versions of cost item assemblies and reuse them in multiple places.

15.4.1 Accessing the Cost Item Assembly Sub Assemblies

A sub-assembly can be created within a cost item assembly by simply inserting it as a subordinate cost
item.

To access a cost item assembly record, select Setup > Cost Item Assemblies. The Cost Assembly
register will open.

Select the cost item you want to open by double clicking or right click and select Open.
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15.4.2 Overview of the cost item assembly sub assembly

Under the Cost Items window you will see the cost item assemblies listed. On the right side of the
screen will be the sub assemblies relating to each cost item.
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When you expand the sub assemblies on the right, it lists all the elements which make up that sub
assembly.

On the Cost Item Assembly Record screen there are three windows. Below are their functions:
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Windows Description

1 Cost Items
These are the component cost items that will be inserted when the assembly is
employed. Fields on the cost items can be linked to Calculations, which are driven
by the Input values in window 2.

2 Inputs /
Calculations

Inputs: These are the inputs the user will specify during employment of the
assembly. These input values drive the Calculations which can be linked to the cost
items in window 1.
Calcutions: This is where Calculations are defined. Calculations can be based on
Input values and other Calculations, and the Calculation results can be linked to
fields on the assembly’s cost items and resource employments.

3
Sub
Assemblies

Four tabs appear: Notes, Setup, Tables, and Osub Assemblies.
l Notes are displayed when the assembly is employed
l Setup shows file and Tag information
l Tables link to individual Table Records by Table Code
l Sub Assemblies list all the elements which make up that sub assembly

Selecting the Default Data Blocks icon in the top left of the screen will change the view of the Cost
Item Assembly Record.
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The cost item assemblies input values can then be assigned to the sub-assembly input values for you to
answer a question only one time. For example, when providing the total square footage of a wall
system, the single input can be used by the cost item assembly and its sub-assemblies. Adjusting values
in the questions, will change the preview, as shown below.

From the Cost Item Assembly Record > Sub Assemblies tab, compare how changes affect the Cost
Breakdown Structure (CBS) Register:

Changing these values will…

adjust these totals.
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Sub-assembly input values can be sorted and shown conditionally based upon your inputs. Then you can
employ a cost item assembly which only views the questions that are relevant. For example, a question
in the cost item assembly could be, "Is insulation required?". If the answer to the question is yes, then a
sub-assembly that defines the cost of installing insulation gets included in the cost item assembly. If the
answer is no, then the sub-assembly is not included.

To view the formulas used to calculate the values of the cost items, in the Cost Breakdown Structure
(CBS) Register hover over the Forecast (T/O) Quantity line items. This will help you to understand how
these values were determined.

When your Input questions require answers as Yes/No, Unit of Measure, etc., select the field’s ellipse
to open the table screen. Here you can select the item(s) which relate to your initial selection. When
OK is selected, the line item will update with the new selection.
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15.4 Step by Step 1 — Creating a Cost Item Assembly Sub Assembly

1. Navigate to Setup > Cost Item Assemblies.

2. Select a cost item assembly.

l The cost item assembly record will open
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3. With the addition of “Walls” as our example. select a blank line in the Cost Item Assembly and
give it a number and description.

4. Right click on the line item and select Insert Cost Item Assembly as Subordinate.
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l The Cost Item Assembly Register sub assembly opens

5. From this screen, select a sub assembly to add and click OK.
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l The window for the sub assembly will open with its details

l Complete any changes to the values

6. Click OK.

The cost item sub assembly has been added:
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Lesson 15 Review

1. Where do you create new cost items for the cost item assembly?

a. CBS Register

b. Cost Item Assembly Record

c. Job Properties

d. Cost Item Assembly Register

2. From where can you edit an employed cost item assembly?

a. CBS Register

b. Cost Item Assembly Record

c. Resource Rate Register

d. Both a & b

3. Match each function to its correct definition:

Term Definition

Iif Rounds the given value to the nearest integer

Round Returns the maximum value for the specified values

Pi Returns the value of Pi

Max Returns either TruePart or FalsePart depending on the Boolean expression

Lesson 15 Summary

As a result of this lesson, you can:

l Explain what a cost item assembly is and why it is used

l Create and edit a cost item assembly

l Employ a cost item assembly
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